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IMPORTANT: Avid periodically makes software updates and Customer Patch 
Releases (CPR) available for download on Avid.com at the following location:

www.avid.com/support/downloadcenter/index.asp

Please check the above site regularly for information on available downloads for 
your product.

Important Information

Avid® recommends that you read all the information in this ReadMe file thoroughly before 
installing or using any new software release. 

Important: Search the Avid Knowledge Base for the most up-to-date ReadMe file, which 
contains the latest information that might have become available after the documentation 
was published.

This document describes compatibility issues with previous releases, software installation 
instructions, hardware and software requirements, and summary information on system and 
memory requirements. This document also lists hardware and software limitations.

http://www.avid.com/support/downloadcenter/index.asp
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Symbols and Conventions

ReadMe documents use the following symbols and conventions:

If You Need Help

If you are having trouble using your Avid product:

1. Retry the action, carefully following the instructions given for that task in this guide. It 
is especially important to check each step of your workflow.

2. Check this ReadMe file for the latest information that might have become available after 
the documentation was published. Also check online for the most up-to-date ReadMe 
because the online version is updated whenever new information becomes available. To 
view the online ReadMe, select ReadMe from the Help menu, or visit the Knowledge 
Base at http://www.avid.com/readme.

3. Check the documentation that came with your Avid application or your hardware for 
maintenance or hardware-related issues. In addition to the printed documentation 
supplied with your editing application, the documentation is supplied in PDF format 
when you install the application. Topics that you print from the Help have limited page 

Symbol or Convention Meaning or Action

n A note provides important related information, reminders, 
recommendations, and strong suggestions.

c A caution means that a specific action you take could cause harm to 
your computer or cause you to lose data.

w A warning describes an action that could cause you physical harm. 
Follow the guidelines in this document or on the unit itself when 
handling electrical equipment.

> This symbol indicates menu commands (and subcommands) in the 
order you select them. For example, File > Import means to open the 
File menu and then select the Import command.

This symbol indicates a single-step procedure. Multiple arrows in a list 
indicate that you perform one of the actions listed.

Italic font Italic font is used to emphasize certain words and to indicate variables.

Courier Bold font Courier Bold font identifies text that you type.

Ctrl+key or mouse action
k+key or mouse action

Press and hold the first key while you press the last key or perform the 
mouse action. For example, k+Option+C or Ctrl+drag.

http://www.avid.com/readme
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layout and formatting features. If you want to print a higher quality version of Help 
information, Avid recommends that you print all or part of the PDF version of the 
appropriate Avid manual included in the Online Library for your editing application. To 
access the Online Library, select Help > Online Library from within your Avid editing 
application. 

4. Visit Avid Online Support at www.avid.com/onlineSupport/. Online support is available 
24 hours per day, 7 days per week. Search the Knowledge Base to find answers, to view 
error messages, to access troubleshooting tips, to download updates, and to read or join 
online message-board discussions.

Fixed in v4.0.2

The following have been fixed:

➤ Bug Number: . In the v4.0 and v8.0 editing application release, choosing the trial version of 
software activation on systems using a dongle would deactivate the dongle if you 
subsequently chose to activate using the dongle. This has been fixed. Choosing the trial 
option for systems with a dongle will no longer deactivate the dongle once you select the 
dongle option.

➤ Bug Number: UDevC00130743. When “Show four-frame display” was enabled, and 
“Dynamic relink” was enabled and you dragged clips in Segment mode, you would receive 
C++ exceptions. This has been fixed.

➤ Bug Number: UDevC00125435. When performing an Edit while Capture, if you checked 
the clip out of the editor bin and loaded the clip once the ingest was completed, you would 
receive an “OBSERVE : ERROR Audio::PMM_INSUFFICIENT_MEDIA Player version of 
frame duration is longer than actual” error. This has been fixed.

Changed in v4.0.1

No documented changes. This was a limited release.

http://www.avid.com/onlinesupport
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Before You Install the Editing Application

Read through the following procedures prior to installing the editing application.

(Windows Only) Missing Video Plug-ins

If you are updating from Avid Media Composer 3.x, Symphony 3.x, or NewsCutter 7.x to 
Avid Media Composer v4.0.x, Symphony v4.0.x or NewsCutter v8.0.x, you must perform 
the following to fix the AVX Plug-ins path. If you do not perform this procedure, various 
video effects, such as Illusion FX, Avid PanZoom, RGB Keyer, may not show up in the 
Effects Palette. The first procedure below provides the steps to be performed if you read this 
before installing the editing application. In the event that you did not read this prior to 
installing the editing application, follow the second set of steps.

To fix the path prior to upgrading to the v4.0.2 or v8.0.2 the editing application:

1. Log on as Administrator.

2. Select Start > Run.

3. Type Regedit to enter the Registry Editor application.

4. Do one of the following depending on your OS:

t (Windows Vista 64) Navigate to the following: 
HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Avid Technology\AVX 
Plug-ins

Update the Directory entry to add a “\” after Avid. For example, C:\Program Files 
(x86)\Avid to C:\Program Files (x86)\Avid\

t (Windows XP 32) Navigate to the following:

HKLM\Software\Avid Technology\AVX Plug-ins 

Update the Directory entry to add a “\” after Avid. For example, C:\Program 
Files\Avid to C:\Program Files\Avid\

To fix the path after upgrading the v4.0.2 or v8.0.2 editing application:

1. Log on as Administrator.

2. Do one of the following depending on your OS:

(Windows Vista 64) Copy the contents of C:\Program Files (x86)\AvidAVX_Plug-Ins to 
C:\Program Files (x86)\Avid\AVX_Plug-Ins 

(Windows XP 32) Copy the contents of C:\Program Files\AvidAVX_Plug-Ins to 
C:\Program Files\Avid\AVX_Plug-Ins 
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Existing Editor Upgrades

Use the following information to determine which editing applications can be installed on 
your system. The following existing editing applications can be upgraded to the following 
listed versions: 

• Media Composer versions v2.7.x and higher can upgrade to Media Composer v3.x and 
higher (on Windows® XP OS). 

• Symphony™ Nitris® versions v1.7.x and higher can upgrade to Symphony Nitris v3.x 
and higher (on WinXP OS). If you are an Avid DS Nitris and Avid Symphony Nitris 
Dual Boot customer, you cannot upgrade to Symphony v3.0 and higher.

• NewsCutter XP and NewsCutter Adrenaline versions v6.7.x and higher can upgrade to 
NewsCutter v7.x and higher (on Windows XP OS).

If you are a new customer (never installed an Avid editor on your system) you can install the 
following on an approved WinXP system or an approved Windows® Vista system:

• Media Composer v4.0 and higher

• Symphony Nitris v4.0 and higher

• NewsCutter v8.0 and higher

The following upgrade process to the Windows Vista version of the editing application is not 
supported:

For example, if a Media Composer v2.7.x customer uninstalled the editing application, 
upgraded the OS from WinXP to Windows Vista, and then tried to install Media Composer 
3.x or higher, the installation would fail. The only allowable Windows Vista editing 
application installation is on a clean Windows Vista system.

The Macintosh® version of the Media Composer v3.x and higher release can only be 
installed on a clean Macintosh with Mac OS® X Leopard.

Notes on Windows Vista OS

Note the following topics if you are running the editing application on the Windows Vista 
OS.

Disabling Desktop Compositing

If you are running an editing application on the Windows Vista OS, when the Avid editor is 
launched you might see a dialog box asking you to disable desktop compositing. You can 
disable it without adversely affecting the Avid editing application.
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You can choose to disable it and continue with your editing session. The dialog will appear 
once you relaunch the application unless you disable the option.

To disable the desktop compositing:

1. Access the Control Panel.

2. Double-click System.

3. Click Change Settings.

4. Click the Advanced tab.

5. Under the Performance area, click Settings.

6. Uncheck “Enable desktop composition.”

The dialog box requesting you to disable desktop compositing does not appear the next 
time you launch the editing application. 

User Access Control Setting

Windows Vista includes User Access Control (UAC), which makes you aware of changes 
that will be made to your computer letting you decide to allow the changes or not. Avid 
recommends that you leave UAC ON. This feature is turned on by default in the Windows 
Vista operating system.

Standard User

You need to first install the editing application as an Administrator. If you are in a Shared 
Storage environment, mount your workspaces as an Administrator. You may then log off and 
log back in as a Standard user, if necessary.

Windows Vista Windows Sidebar

If the Vista Windows Sidebar is enabled, you might see flickering on the Timeline monitor 
when you stop playback. You should disable Windows Sidebar:

To disable the Windows Vista Sidebar:

1. Right-click the Sidebar or Sidebar icon, and select Properties.

2. Deselect “Start Sidebar when Windows starts.” 

3. Right-click the icon, and select Exit to close the sidebar.
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New Folder Structure

Some editing application folders have moved to a new location that is now shared and 
visible to the user on installation. These folders are created at installation time and are given 
special permissions to work for all users.

The following folders are created on your Windows XP system in the following location:

C:/Documents and Settings/AllUsers/Shared Documents/<AvidProductName>

• Avid Attic

• Avid Users

• Avid Media_Files

• Avid Templates

• Settings

• Avid FatalErrorReports

• sharedjvm/server/apps/MediaIndexer/stat/log

• MarqueeTitles

• AVX Plug-Ins Data

The following folders are created on your Windows Vista system in the following location:

C:/Users/Public/Public Documents/<AvidProductName>

• Avid Attic

• Avid Users

• Avid Media_Files

• Avid Templates

• Settings

• Avid FatalErrorReports

• sharedjvm/server/apps/MediaIndexer/stat/log

• MarqueeTitles

• AVX Plug-Ins Data

Cleaning up Old Folders Before Installation

Do the following to clean up old folders before you install the new ones if you are 
performing an upgrade from a version prior to Media Composer 3.0,  .
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To clean up folders:

1. Before installing Media Composer 4.0,   you need to uninstall your old version and any 
version of FilmScribe, EDL Manager, MediaLog, and Avid Log Exchange. 

2. Remove the following Registry keys on your system if they still exist after the 
uninstallation process.

HKLM/Software/Avid Technology/<productname>

HKLM/Software/Avid Technology/AVX Plug-ins

3. From the following folders, remove any folders that do not have custom data in them 
that you want to keep. If you do have custom data, copy the data to the new locations 
after step 4.

C:/Documents and Settings/AllUsers/ApplicationData/Avid/<productname>

C:/Program Files/Avid/<ProductName>

(Windows Vista) C:/ProgramData/Avid/<Productname>

4. Install the new Avid editing application.

Installing the Software

Prior to installing the editing application, you should uninstall Digi Drivers using 
Add/Remove from the Control Panel. Reboot the system and then install the new editing 
application. If you do not remove the Digi Drivers, the Audiosuite plug-ins do not load and 
you might receive either the error message “This software requires installation of device 
driver TPkd and a reboot before running” or a “DAE Interface NOT Available” error 
message. If you see these errors on a clean installation on a brand new system, install Hot fix 
KB926255 from Windows Update to fix the problem.

(Macintosh Only) If you are upgrading from a previous version of the Macintosh editing 
application, remove the Stereo Mixer.dpm and Surround Mixer.dpm plug-ins from the 
following location: Macintosh HD/Library/Application Support/Digidesign/Plug-Ins. If you 
do not remove these files, you might experience problems with the AudioSuite Tool.

For all Avid editing applications, you must first log in as the Administrator (not just a user 
with administrator privileges), install the application, and initially launch the application as 
the Administrator. If you are working in a shared storage environment, mount your 
workspaces. You may then subsequently run the Avid editing application as a regular User.

If you are updating from a previous release, you should first uninstall the existing editing 
application. 
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(Windows) To uninstall the Avid editing application software do one of the following:

t Using the Add/Remove program, remove the editing application.

t During the installation process, when prompted, choose to uninstall the editing 
application.

(Windows) To install the Avid editing application software:

1. Quit all active applications.

2. Insert the editing application DVD.

3.  Click to Install the Avid Editor Suite or Individual Product and follow the on screen 
instructions.

n If the FilesInUse dialog box appears, you can safely select Ignore and continue.

n Depending on Windows activity on your system, some Microsoft Windows Driver Warnings 
might be minimized into your task bar at installation time. If your installation is taking 
longer than 5-10 minutes, please check your task bar for an icon with the word SOFTWARE 
in it. Click the icon and you may safely select Continue Anyway to continue your 
installation.

4. When prompted, select “Yes, restart my computer.”

(Macintosh) To uninstall the Avid Editing application software:

1. Quit all applications.

2. Go to Applications/Avid_Uninstaller/AvidEditingApplication

3. Double-click the AvidEditingApplication uninstaller.

4. Follow the on-screen prompts.

(Macintosh) To install the Avid Editing application software:

1. Quit all applications.

2. Insert the editing application DVD.

3. Click to Install the Avid Editor Suite or Individual Product and follow the on screen 
instructions.

4. When prompted, select “Yes, restart my computer.”

Firmware Update Note

When you first start your editing application after installing, you might receive a dialog box 
requiring you to update the Avid hardware firmware. Choose to Update. During the update 
process, do not access any other applications or move any of the active windows. Accessing 



  

12

another application might result in the update completion dialog box being hidden. If this 
happens, you will see the update progress stay at 100% but have no option to proceed. The 
hidden window which states the update is complete and prompts you to shutdown, cannot be 
brought to the foreground. Shutdown the system. Do not just Restart. You must choose to 
fully Shutdown and then power up your system again.

Notes on Software Licensing

Activating Your Avid Editing Application

Avid has modified the options you have when activating the license for your editing 
application. The licensing options provide you with more flexibility when activating your 
software.

• You can run a fully-featured trial version of your Avid editing application for 30 days. 
Previously, the trial period lasted for 14 days.

• You can activate your application using an application key (dongle). In the previous 
release, this option was available only to qualified upgrade customers.

You activate your software using the Avid Activation tool, which opens when you first start 
your application. For more information on activating your software, see the Installation 
Guide for Avid Editing Applications.

n You cannot activate your software using the Avid License Service. This feature will be 
supported in a future release.

If You Upgrade Your Operating System

If you need to upgrade your operating system after you install your Avid editing application, 
first deactivate your software. After you upgrade your operating system and, if required, 
reinstall your application, you can reactivate your software. For information on activating 
and deactivating your software license, see the Installation Guide for Avid Editing 
Applications.

Laptop Network Settings

Your software license uses information from your system’s network configuration. Some 
laptops disable the Network Interface Card (NIC) when connecting to the Internet through a 
wireless network connection. If you run your Avid editing application on a laptop, be sure 
that your NIC and wireless configuration is always the same as when you originally 
activated your software. See the user assistance for your computer for information on 
changing network settings.
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Using the GetLicenseInfo Utility

Avid provides a utility program — GetLicenseInfo.exe — that retrieves information specific 
to your license. This is useful if you no longer have the original license information or if you 
need to provide this information to Avid Customer Support. The license information 
retrieved by the utility depends on your system, but it can include the following:

• Avid editing product name

• License type

• Status

• System ID

• Serial number (for security reasons, only part of the serial number is displayed)

• Avid machine ID

To retrieve license information:

1. Navigate to one of the following locations:

t (Windows) Program Files\Avid\Utilities\GetLicenseInfo

t (Macintosh) Applications/Utilities/Avid Utilities/GetLicenseInfo

2. Double-click GetLicenseInfo.exe

A terminal window opens and displays your license information.

3. Copy the appropriate license information, and then close the terminal window.

Codec Update

The release of Avid Media Composer v4.0 includes improvements to Avid’s DNxHD codec 
to bring it into compliance with the SMPTE VC-3 specification. With this release, the 
editing application continues to decode any DNxHD media created by a previous version of 
the editing application. However, previous versions of the editing application are not able to 
playback media created with the new release. All prior Avid editing versions will need the 
updated codec's. Codecs are available for editing applications v3.x and above. 

If you don't install the newer Avid codecs, the following occurs: When you play compliant 
DNxHD media in a previous editor application, it may result in frames being decompressed 
incorrectly. This is characterized by only the top half of a frame being decompressed with 
the bottom half of the image displaying with either black or green. If you install the updated 
codec in these earlier editor application, it will correct the decoding. Avid has included two 
updated codec files that you can copy to your previous versions (3.x, 7.x and above) of the 
editing application that allow you to play media that you created with your new editing 
application.
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n The changes affect only DNxHD 1080i/59.94 and DNxHD 1080i/50 formats. All progressive 
formats, for example, 720p and 1080p are unaffected.

Installing Updated Codec Files

Copy the updated codec files from the Avid Media Composer v4.0, Avid Symphony v4.0 or 
the Avid NewsCutter v8.0 and place them in the appropriate folder of the earlier version 
(3.x, 7.x and above) editing application.

To update to the latest codec files:

1. Make sure the editing application is not running.

2. Go to the following location in the Avid Media Composer v4.0, Avid Symphony v4.0 or 
the Avid NewsCutter v8.0 application.

(Macintosh) Right-click the editing application executable. Select Show Package 
Contents > Contents > SharedSupport > AVX2_Plug-Ins > Codecs

(Windows) Program Files > Avid > Avid Editing Application > AVX2_Plug-Ins > 
Codecs

3. Copy the following files:

CodecManager.avx

CMAvidHDCodec.avx

4. Access the previous version editing application.

5. Paste the two files in the following location.

(Macintosh) Right-click the editing application executable. Select Show Package 
Contents > Contents > SharedSupport > AVX2_Plug-Ins > Codecs

(Windows) Program Files > Avid > Avid Editing Application > AVX2_Plug-Ins > 
Codecs

6. Restart the editing application.

n The previous version of the editing application must also have the latest Avid QuickTime 
codecs (v2.1). The Avid QuickTime codecs executable is supplied with the latest editor 
installer. Run the AvidCodecsLESetup.exe (Windows) or AvidCodecsLE.pkg (Macintosh) on 
any editor system that will be playing back new media.

Supported Hardware and Operating Systems

The following tables provide the information on supported Windows and Macintosh 
hardware. The following tables also list the supported Operating Systems. Depending upon 
your hardware the supported Operating Systems are:
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• Windows XP 32 (SP2 and SP3)

• Windows Vista 32 (SP1 and SP2)

• Windows Vista 64 (SP1 and SP2)

• Macintosh Leopard 10.5.7 and 10.5.8

Supported PC Workstations with Avid Media Composer

The following PC Workstations are supported with Avid Media Composer v4.x.

Supported PC 
Hardware Graphics Card Supported OS Supported with 

HP z800 Dual Quad 
Core, 2.93 GHz 

NVIDIA Quadro 
FX 4800 

Windows XP 32 
Windows Vista 64 

Software Only
Adrenaline (See “Required 
Hotfix Info” on page 20)
Nitris DX
Mojo DX
Mojo SDI (See “Required Hotfix 
Info” on page 20)

HP z400 Single Quad 
Core, 2.93 GHz

NVIDIA Quadro 
FXWindows 3800 

Windows XP 32 
Windows Vista 64 

Software Only
Adrenaline (See “Required 
Hotfix Info” on page 20))
Nitris DX
Mojo DX
Mojo SDI (See “Required Hotfix 
Info” on page 20)

Dell T5500 Dual, 
2.93GHz Quad Core

NVIDIA Quadro 
FX 4800 

Windows Vista 64 Software Only
Nitris DX
Mojo DX
Mojo SDI (requires additonal 
1394b card - StarTech 
PEX1394B3)

Dell T3500 Single 
Quad Core, 2.93GHz 

NVIDIA Quadro 
FX 3800 

Windows Vista 64 Software Only
Nitris DX
Mojo DX
Mojo SDI (requires additonal 
1394b card - StarTech 
PEX1394B3)
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Dell™ T5400 Dual 
Quad Core, 2.50 to 3.16 
GHz 

NVIDIA Quadro 
FX 3700

Windows XP 32 
Windows Vista 64 

Software Only
Adrenaline
Nitris DX
Mojo DX
Mojo SDI
Mojo

Dell T3400 Core 2 Duo, 
2.33 or 2.66GHz

NVIDIA Quadro 
FX 3700 or 
NVIDIA Quadro 
FX 570

Windows XP 32 
Windows Vista 64 

Software Only
Adrenaline
Mojo DX
Mojo SDI
Mojo

HP xw9300 2.0 GHz 
Dual Dual Core

NVIDIA Quadro 
FX 3500,

Windows XP 32 Software Only

HP xw8600 NVIDIA Quadro 
FX 3700 

Windows XP 32 
Windows Vista 64 

Software Only
Nitris DX
Mojo DX
Adrenaline
Mojo SDI
Mojo

HP xw8400 Dual Quad 
Core, 2.33, 2.66, or 
3.0MHz

NVIDIA Quadro 
FX 1500 or 
NVIDIA Quadro 
FX 3500 or 
NVIDA Quadro 
FX 3700

Windows XP 32 
Windows Vista 64 

Software Only
Nitris DX
Mojo DX
Adrenaline
Mojo SDI
Mojo

HP xw8400 Dual Dual 
Core, 2.66 3.0MHz

NVIDIA Quadro 
FX 1500 and 
NVIDIA Quadro 
FX 3500 and 
Quadro FX 3700

Windows XP 32 
Windows Vista 64 

Software Only
Nitris DX
Mojo DX (no DNxHD capture)
Adrenaline
Mojo SDI
Mojo

HP xw8200 Dual 3.4 or 
3.66 GHz xeon

NVIDIA Quadro 
FX1300 or 
FX1400 
If you use the 
FX1300 card, use 
the 169.47 driver.

Windows XP 32 Software Only
Adrenaline
Mojo SDI
Mojo

Supported PC 
Hardware Graphics Card Supported OS Supported with 
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Supported PC Notebooks for Avid Media Composer

The following PC Notebooks are supported with Avid Media Composer v4.x. DNxHD 
capture is not possible on a notebook.

HP xw4600 Core 2 Duo 
3.0 GHz

NVIDIA Quadro 
FX570

Windows XP 32 
Windows Vista 32, 
Windows Vista 64 

Software Only
Adrenaline
Mojo DX (no DNxHD capture)
Mojo SDI
Mojo

Supported PC 
Hardware Graphics Card Supported OS Supported with 

Supported PC 
Notebooks Graphics Cards Supported OS Supported With

HP 8730w Core 2 Duo 
2.53, 3.06 GHz 

NVIDIA FX 2700m 
and NVIDA FX 
3700m

Windows XP 32
Windows Vista 32

Software Only
Mojo DX (no DNxHD capture)
Mojo SDI (requires PCI Express 
FW800 add in card)

HP 8530w Core 2 Duo
2.53, 3.06 GHz

NVIDA FX 770m Windows XP 32
Windows Vista 32

Software Only
Mojo DX (no DNxHD capture)
Mojo SDI (requires PCI Express 
FW800 add in card)

Dell 6400 Core 2 Duo
2.53, 3.06 GHz

NVIDIA FX 2700m 
and NVIDA FX 
3700m

Windows XP 32
Windows Vista 32

Software Only
Mojo DX (no DNxHD capture)
Mojo SDI (requires PCI Express 
FW800 add in card)

HP 8510 with docking 
station 
Core 2 Duo
2.2GHz

NVIDIA Quadro FX 
570M

Windows XP 32 
Windows Vista 32

Software Only
Mojo DX (no DNxHD capture)
Mojo SDI
Mojo

HP 8710W Intel® Core™ 2 
Duo processor T7700 2.40 
GHz with docking station. 

NVIDIA Quadro FX 
1600m

Windows XP 32 
Windows Vista 32

Software Only
Mojo DX (no DNxHD capture)
Mojo SDI
Mojo

Dell 6300 Intel Core 2 Duo 
processor T7700 2.4 GHz

NVIDIA Quadro FX 
1600m

Windows XP 32 
Windows Vista 32

Software Only
Mojo DX (no DNxHD capture)
Mojo SDI
Mojo
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Supported Macintosh Workstations for Avid Media Composer

The following Macintosh Workstations are supported with the Avid Media Composer v4.x.

HP nw9440 2.16 GHz Intel 
Core Duo 

NVIDIA Quadro FX 
1500M

Windows XP 32 Software Only
Mojo DX (no DNxHD capture)
Mojo SDI
Mojo

IBM T61P Intel Core 2 Duo 
T77002.4 GHz 800 Mhz

NVIDIA Quadro 
FX570M

Windows XP 32 Software Only
Mojo SDI
Mojo

Dell Precision M65 Intel 
Core Duo or Core 2 Duo 
processor 2.16 GHz

NVIDIA Quadro 
FX350M

Windows XP 32 Software Only

Dell Precision M90 Intel 
Core Duo processor 2.16 
GHz

NVIDIA Quadro FX 
2500M / 1500M

Windows XP 32 Software Only
Mojo SDI
Mojo

Supported PC 
Notebooks Graphics Cards Supported OS Supported With

Supported 
Macintosh 
Hardware Graphics Cards Supported OS Supported With

Mac Pro “Nehalem” 
Dual 2.66 GH Quad 
Core Intel Xeon or Dual 
2.93 GHz Quad Core 
Intel Xeon

NVIDIA GeForce GT 
120

Leopard v10.5.7 
and v10.5.8

Software Only
Nitris DX
Adrenaline
Mojo DX
Mojo SDI
Mojo

Mac Pro “Nehalem” 
Dual 2.26 GHz Quad 
Core Intel

NVIDIA GeForce GT 
120

Leopard v10.5.7 
and v10.5.8

Software Only

Mac Pro “Harpertown” 
Dual Quad Core 3.0 or 
3.2 GHz

NVIDIA GeForce 
8800GT

Leopard v10.5.7 
and v10.5.8

Software Only
Nitris DX
Adrenaline
Mojo DX
Mojo SDI
Mojo
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Supported Macintosh Notebooks for Media Composer

The following Macintosh notebooks are supported with the current editing applications. 
DNxHD capture is not supported on notebooks. DNxHD capture is not supported on Mojo 
DX on Notebooks. Nitris DX is not supported on laptops.

Mac Pro Dual 
Quad-Core 3GHz or 
higher Intel processor

NVIDIA GeForce 
7300 GT

Leopard v10.5.7 
and v10.5.8

Software Only
Nitris DX
Adrenaline
Mojo DX
Mojo SDI
Mojo

Mac Pro Dual 
Dual-Core 2.66 GHz or 
higher Intel processor

NVIDIA GeForce 
7300 GT 

Leopard v10.5.7 
and v10.5.8

Software Only
Nitris DX
Adrenaline
Mojo DX (no DNxHD capture)
Mojo SDI
Mojo

iMac 20” Display 
2.66 GHz 4 GB RAM 

GeForce 9400 Leopard v10.5.7 
and v10.5.8

Software Only

Supported 
Macintosh 
Hardware Graphics Cards Supported OS Supported With

Supported Macintosh 
Notebook Graphics Cards Supported OS Supported With

MacBook Pro 2.66 GHz Intel 
Core 2 Duo processor, 17” 
display, 4GB 1066MHz DDR3, 
250GB ATA 7200 rpm drive

NVIDIA GeForce 
9400M and 9600M 
GT

Leopard v10.5.7 
and v10.5.8

Software Only
Mojo DX(no DNxHD capture)
Mojo SDI
Mojo

MacBook Pro 2.53 GHz Intel 
Core 2 Duo processor, 15” 
display, 4GB 1066MHz DDR3, 
250GB ATA 7200 rpm drive

NVIDIA GeForce 
9400M and 9600M 
GT

Leopard v10.5.7 
and v10.5.8

Software Only
Mojo DX(no DNxHD capture)
Mojo SDI
Mojo

MacBook Pro 2.5 GHz Intel Core 
2 Duo processor, 15” & 17” 
Display

Leopard v10.5.7 
and v10.5.8

Software Only
Mojo DX(no DNxHD capture)
Mojo SDI
Mojo
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Required Hotfix Info

If you have an HP z800 or HP z400 system and are running Windows XP 32 OS, you must 
install a Microsoft WinXP32 SP3 hotfix in order for the supported OHCI card to function 
properly with Avid DNA hardware. Download the Hotfix from the following location.

http://support.microsoft.com/hotfix/KBHotfix.aspx?kbnum=955408&kbln=en-us

The hotfix page indicates that this fix is for SP4. The fix is actually for SP3. It is safe to take 
this fix for SP3.

Restart your system after running the hotfix.

Compatibility Chart

The following table lists the operating system, NVIDIA® driver, QuickTime®, Windows 
Media™, Avid Interplay®, shared storage, Sony® XDCAM™, Panasonic® P2, and Pro Tools 
LE® versions that were qualified with the Avid editing applications. Also listed are the 
third-party applications such as Boris Continuum Complete, Avid DVD by Sonic™, 
Sorenson Squeeze®, and SmartSound® that ship with the editing applications.

MacBook Pro 2.4 GHz Intel Core 
2 Duo processor, 15” & 17” 
Display

NVIDIA GeForce FX 
8600m GT graphics 
with 256MB SDRAM 

Leopard v10.5.7 
and v10.5.8

Software Only
Mojo DX(no DNxHD capture)
Mojo SDI
Mojo

MacBook Pro 2.16 GHz Intel 
Core Duo processor, 17” or 15” 
display

Leopard v10.5.7 
and v10.5.8

Software Only
Mojo DX(no DNxHD capture)
Mojo SDI
Mojo

MacBook Pro 2.33 GHz Intel 
Core 2 Duo processor, 17” or 15” 
display

Leopard v10.5.7 
and v10.5.8

Software Only
Mojo DX(no DNxHD capture)
Mojo SDI
Mojo

Supported Macintosh 
Notebook Graphics Cards Supported OS Supported With

Item Versions Comments

QuickTime Support 7.6.4
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Windows Media 
Version Support

Windows Media Player 11 If you do not have Windows Media Player 
11, access the download at 
www.microsoft.com.

Windows Media export compatibility is 
subject to Microsoft Windows Media 
updates.

Avid Interplay 
Support

See the Avid Interplay ReadMe 
for supported versions.

Macintosh editing applications are not 
supported in an Avid Interplay 
environment. IMPORTANT: The Avid 
Interplay components that get installed on 
the editing application must be updated to 
the Avid Interplay version that is released 
with the editing application. These include 
the Media Indexer, Interplay Access, 
Interplay Framework, Interplay Transfer 
Client and ProEncode Client. The Avid 
Interplay Server components can remain 
on the previous releases listed as 
supported. For details, see the “Avid 
Editing Application Compatibility with 
Interplay Releases” topic in the Avid 
Interplay ReadMe.

NVIDIA Driver 
Support

v182.65
(This is the version of driver 
tested with our editing 
applications. DO NOT upgrade to 
any other version.)

See “Setting up the NVIDIA Card” on 
page 27.

Shared Storage 
Support

Avid Unity™ MediaNetwork and 
Avid Unity ISIS®.

See “Shared Storage Support” on page 29.

Item Versions Comments

http://www.microsoft.com/en/us/default.aspx
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Pro Tools Pro Tools LE v7.3.1 and v7.4.x

Pro Tools LE v8.0cs1 and higher.

Pro Tools HD v8.0cs1and higher.

For information on supported versions of 
Pro Tools in an Interplay environment, see 
the Avid Interplay ReadMe.

Interoperability is supported with 
Pro Tools LE v7.3.1 and v7.4.x; Co-install 
is not supported with these versions.

With Pro Tools HD v8.0cs1, Media 
Composer supports the Video Satellite 
feature. For more information, see the 
Video Satellite Guide provided by 
Digidesign®. 

With Pro Tools LE v8.0, and HD v8.0 and 
higher, co-installation of Media Composer 
(Windows and Macintosh) and Pro Tools is 
supported. 
See also “Audio Device Compatibility with 
Avid Editing Applications and Pro Tools” 
on page 23.

Sony XDCAM 
driver

WinXP 32 – FAM 2.1, PDZ 2.50

Vista 64 – FAM 2.2, PDZ 2.50

v2.9.0 (XDCAM Transfer for 
Macintosh)

Avid recommends you install the Pro Disc 
2.04 driver on the Windows XP system 
running SP3 when using the following 
Sony PDW devices: 
PDW 1500, PDW HD1500, PDW 700, 
PDW 350, PDW F75, PDW F70, PDW D1. 
The driver can be downloaded from Sony's 
website http://esupport.sony.com/.

Avid recommends you install the VFAM 
driver v2.2 (WinXP 32) or the VFAM 2.1 
(Macintosh OS) when using the PDWU1 
device. The firmware version is 2.42. The 
driver can be downloaded from Sony's 
website http://esupport.sony.com/.

Panasonic P2 driver (Windows XP and Vista) Driver 
version for P2 devices: v2.09

(Macintosh) Driver version for P2 
devices: v1.33 

There is currently no P2 writeback support 
for Macintosh clients.

Item Versions Comments
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Audio Device Compatibility with Avid Editing 
Applications and Pro Tools

When you install Avid editing applications and Pro Tools on the same system, note the 
following:

• If you install both an Avid editing application and Pro Tools on the same system, the 
co-install does not support both applications launched simultaneously.

• Co-install of Pro Tools LE with Mbox 2 Pro is not supported with Mojo, Mojo SDI, or 
Adrenaline due to IEEE 1394 (FireWire) conflicts.

• Co-install is not qualified with Windows Vista 64.

Boris Continuum 
Complete

v6.0.4 Ships with:
Avid Media Composer
Avid NewsCutter® 
Avid Symphony™ Nitris®

Avid Symphony Nitris DX

Avid DVD by Sonic v6.1 Ships with:
Avid Media Composer
Avid NewsCutter
Avid Symphony Nitris
Avid Symphony Nitris DX

Sorenson Squeeze v5.1.1 Ships with:
Avid Media Composer
Avid NewsCutter
Avid Symphony Nitris
Avid Symphony Nitris DX

SmartSound 
Sonicfire® Pro

v5.1.1 Ships with:
Avid Media Composer
Avid NewsCutter 
Avid Symphony Nitris
Avid Symphony Nitris DX

Avid FX v5.8 Ships with:
Avid Media Composer
Avid NewsCutter 
Avid Symphony Nitris
Avid Symphony Nitris DX

Item Versions Comments
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• To install Pro Tools and an Avid editing application on the same system, install Pro 
Tools first and then the editing application.

• When you uninstall Pro Tools, choose to uninstall just the application and not the audio 
drivers. On a Macintosh Pro Tools system, this is named the “Safe Uninstall.”

• Media Composer and Avid NewsCutter were tested with the Mbox, Mbox 2, and Mbox 
2 Mini as valid I/O peripherals. If you uninstall the audio drivers for these devices, the 
editing application no longer sees the devices.

• If you install Avid editing hardware on your system — Mojo, Mojo SDI, Adrenaline, 
Mojo DX, or Nitris DX — the editing application does not recognize any connected 
Mbox and Mbox 2 as audio devices.

• If you run into any issues, uninstall both applications and reinstall Pro Tools first, then 
your editing application.

Co-Install Supported Configurations

The following table provides a list of supported Avid Media Composer v3.5.2 and later 
products with the Pro Tools v8.0 peripherals.

• Co-install — Indicates that you can install the device on the same system as you install 
your Avid editing application. For a list of devices supported for audio input/output 
operations with your Avid editing application, see “Audio Device Supported 
Configurations” on page 25.

• Not supported — Indicates that you cannot install the audio device on a supported Avid 
editing system.

• Not Tested — Indicates that Avid has not tested the device with a supported Avid 
editing system configuration.

Pro Tools 
(Interface)

MC Software 
Only

MC with 
Mojo 

MC with 
Mojo SDI

MC with 
Adrenaline

MC with 
Mojo DX

MC with 
Nitris DX

Mbox 
(USB 1.1)

Co-install Co-install Co-install Co-install Not Tested Not Tested

Mbox 2 
(USB)

Co-install Co-install Co-install Co-install Co-install Co-install

Mbox 2 Pro 
(1394)

Co-install Not Supported Not Supported Not Supported Co-install Co-install

Mbox 2 Mini 
(USB)

Co-install Co-install Co-install Co-install Co-install Co-install
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Audio Device Supported Configurations

The following table provides the list of supported Pro Tools v8.0 audio devices that you can 
use for input/output operations with Avid Media Composer v3.5.2 and higher (MC) and 
Avid NewsCutter v7.5.2 and higher (NC). It also lists devices used as control surfaces.

• Supported — Indicates that you can use the audio device for input and output operations 
with your Avid editing application. Some audio devices might not support all 
input/output functionality.

• Supported (1394 only) — Indicates that you can use the audio device for input and 
output operations only when you select 1394 in your Avid editing application. For 
information on using the DNA/1394 button, see “Selecting a DV Device” in the Help.

• Not supported — Indicates that you cannot use the audio device for input/output 
operations with the Avid editing system.

n The Command|8 is also supported as a control surface for Avid Symphony.

Mbox 2 
Micro (USB)

Co-install Co-install Co-install Not Tested Co-install Not tested

Digi 002 
(1394)b

Co-install Co-install Co-install Co-install Co-install Co-install

Digi 003 
(1394)a

Co-install Co-install Co-install Co-install Co-install Co-install

Pro Tools 
HD, in CPU

Co-install Co-install Co-install Co-install Co-install Co-install

Pro Tools 
HD, with 
chassis

Not Tested Not Tested Not Tested Not Tested Not Tested Not Tested

Fast Track 
Pro (USB)

Co-install Not Supported Not Supported Not Supported Not Supported Not Supported

a. Applies to 002 and 003 Rack and Console units, and 003 Rack +. When used with Mojo, Mojo SDI, or Adrenaline, 
connect the 002 or 003 to an approved 1394 HBA card.

Pro Tools 
(Interface)

MC Software 
Only

MC with 
Mojo 

MC with 
Mojo SDI

MC with 
Adrenaline

MC with 
Mojo DX

MC with 
Nitris DX
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Using External Fader Controllers
Your Avid editing application supports the following external fader controllers or mixers for 
automation gain and pan recording or as control surfaces. Only the Digi 002 (on Windows 
systems) and the Command|8 can function as control surfaces.

n External fader controllers or mixers are optional. They are not required for you to perform 
automation gain or pan recording on an Avid editing system.

• Digi 002 (Windows only) and Command|8

• JL Cooper MCS-3000X MIDI automation controller

• JL Cooper FaderMaster Pro MIDI automation controller

• Yamaha® 01V/96 and Yamaha 01V digital mixing console

n The JL Cooper controllers and Yamaha mixing consoles do not support automation pan 
recording.

Pro Tools 
(Interface)

MC/NC 
Software Only

MC/NC with 
Mojo 

MC/NC with 
Mojo SDI

MC/NC with 
Adrenaline

MC/NC with 
Mojo DX

MC/NC with 
Nitris DX

Audio Devices:

Mbox 
(USB 1.1)

Supported Supported 
(1394 only)

Supported 
(1394 only)

Supported 
(1394 only)

Not Supported Not Supported

Mbox 2 
(USB)

Supported Supported 
(1394 only)

Supported 
(1394 only)

Supported 
(1394 only)

Not Supported Not Supported

Mbox 2 
Mini (USB)

Supported Supported 
(1394 only)

Supported 
(1394 only)

Supported 
(1394 only)

Not Supported Not Supported

Digi 002 
(1394)b

Supported 
(Windows)

Supported 
(Windows)

Supported 
(Windows)

Supported 
(Windows)

Not Supported Not Supported

Fast Track 
Pro (USB)

Supported Not Supported Not Supported Not Supported Not Supported Not Supported

Control Surfaces:

Command|8 
(USB)

Supported Supported Supported Supported Supported Supported

Digi 002 
(1394)b

Supported 
(Windows)

Supported 
(Windows)

Supported 
(Windows)

Supported 
(Windows)

Supported 
(Windows)

Supported 
(Windows)
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Windows systems with Avid Adrenaline, Avid Mojo, and Avid Mojo SDI input/output 
hardware can use the Digi 002 as an external audio device. This means you can use the 
Digi 002 to play, record, and output audio. This option is not available for systems with Avid 
Nitris DX and Avid Mojo DX hardware.

The following table compares the external fader controllers and mixers.

For more information on using these external fader controllers or mixers, see “Recording 
Automation Gain or Automation Pan Information” in the Help.

Setting up the NVIDIA Card

To set up the NVIDIA card, you must make sure you have the correct display driver version, 
install the display driver if necessary, and set the correct display settings. This version of the 
editing application requires the following:

Feature

Digi 002
(Windows 
only) Command|8

FaderMaster 
Pro MCS-3000X

Yamaha 01V/96 and
Yamaha 01V

Control surface for 
transport controls and 
other functions

Yes Yes No No No

Provides audio play, 
input, and output

Yes No No No No

Record automation gain Yes Yes Yes Yes Yes

Record automation pan Yes Yes No No No

Flying faders Yes Yes No Yes Yes

Touch-sensitive faders Yes Yes No Yes No

Solo/mute Yes Yes Yes Yes Yesa

a. For Yamaha fader/controllers, solo works only if you do not use the unit for audio mixing at the same time.

Supports audio mixing Nob

b. The Digi 002 can be used as a standalone audio mixer but not at the same time as it is being used as an automation gain 
or automation pan controller or control surface.

No No No Yes

Latch mode (also 
known as Snap mode)

Yes Yes No Yes No

Number of steps of 
fader accuracy

1024 1024 128 1024 256
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Prior to setting up the NVIDIA card, check to make sure you have the correct display driver 
version. If you do not have the correct NVIDIA driver, you can install it from the Utilities 
folder that installs with your Avid application.

• Version 182.65 

Which driver is required depends on the version of the NVIDIA card and the type of 
operating system (Windows XP Windows Vista 32, Windows Vista 64). Installation files for 
these drivers are installed in the folder Program Files\Avid\Utilities\nVidia.

To check the NVIDIA display driver version:

1. Right-click the Desktop and select NVIDIA Control Panel. You can also open the 
Windows Control Panel and double-click the NVIDIA Control Panel icon.

2. Click System Information at the bottom left corner of the NVIDIA Control Panel.

The version number is listed in the Graphics card information section on the ForceWare 
version line.

To install the NVIDIA display driver:

1. Navigate to Program Files\Avid \ Utilities \nVidia and double-click the folder that 
corresponds to your operating system.

2. Double-click the file for the applicable driver.

3. Follow the on-screen instructions, and then restart your system.

To set Dualview mode if you are working with two monitors:

1. Right-click the Desktop, and select Nvidia Control Panel. 

2. In the settings window in the left of the window, click Set up multiple displays.

3. In the “Choose View display mode to use” area, select “Configure independently from 
each other (Dualview).

4. Click Apply, and then click OK.

Disabling the NVIDIA Driver Helper Service 
(Windows XP)

The NVIDIA driver Helper Service is a background program that runs with the NVIDIA 
Driver installed. This service informs you when an update to the NVIDIA Driver is 
available. There have been instances where this service causes slow restarts and shutdown 
with the Avid DNA hardware attached. The service also can prevent the Adobe® 
Photoshop® Gamma loader from operating, which causes color correction settings not to 
work properly. If this occurs, you should disable the NVIDIA Driver Helper Service.
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To disable the NVIDIA Driver Helper Service:

1. Right-click My Computer.

2. Click Manage.

3. Double-click Services and Applications.

4. Double-click Services.

5. Right-click NVIDIA Display Driver or NVIDIA Driver Helper Service.

6. Click Properties.

7. Select Startup Type > Disable.

8. Click OK.

Every time you update or reload the driver, this service is enabled again. 

Shared Storage Support

The editing application has been tested in a shared storage environment with the following:

Editing 
Application 
Operating 
System

ISIS Client 
supported 
version 

ISIS Server 
supported 
version

MediaNetwork 
Client 
supported 
version

MediaNetwork 
Server supported 
version

Windows XP  v1.6, v1.7, 
v2.0.1, v2.0.3, 
v2.0.4

v1.4, v1.5, 
v1.6, v2.0.1, 
v2.0.2

5.1.3  v4.2.4, v5.1.3

Windows Vista 
Business 32 and 
Windows Vista 
Business 64 a

a. Windows Vista Business 32 is supported on some Avid editing applications. See “Supported Hardware 
and Operating Systems” on page 14.

v1.6, v1.7, v2.0.1, 
v2.0.3, v2.0.4

v1.4, v1.5, 
v1.6, v2.0.1, 
v2.0.2

5.1.3  v4.2.4, v5.1.3

Macintosh 
Leopard v10.5.7 
and v10.5.8

v1.6, v1.7, v2.0.1, 
v2.0.3, v2.0.4

v1.4, v1.5, 
v1.6, v2.0.1, 
v2.0.2

5.1.3  v4.2.4, v5.1.3
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New in Avid Media Composer v4.0

What’s New

The following features have been added to this release of the editing application.

• Mixing Frame Rates and Field Motion Types

• Stereoscopic update

• Ancillary Data Handling 

• Video Satellite (supported on the Macintosh)

• 1080p/24 Hi Quality SD/HD Downconvert 

• Auto-Zoom for Motion Tracking and Stabilization

• AAF Edit Protocol support

• 720p Proxy Transcode Workflow

• Clip Color Changes

• Commit Multicamera Edits option

• Edgecode support enhancements for Timecode Burn-in effect

• Transition Preservation

• Recapturing and Decomposing

• Support for Ikegami GFCAM™

• Numeric Keypad and Mouse Support for MultiCamera Editing

• Entering Timecode changes

• Undo up to 100 previous actions.

• Support for rendering, transcoding and mixing down AVC-Intra resolutions

• Support for 16 tracks of audio in the Audio Mixer Tool. See “Documentation Changes” 
on page 69.

For information on new features for the Avid editing products, see the What’s New for Avid 
Media Composer v4.0. The What’s New is provided in PDF form on the Avid Knowledge 
Base. The What’s New is also provided in the online Help.
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Limitations and Known Issues

AMA (Avid Media Access)

➤ Bug Number: . AMA and XDCAM Optical Disks: When accessing media through Avid 
Media Access (AMA), system response time can be affected due to the high latency of the 
XDCAM optical disk. This can affect media access response time while linking, playing 
back, and scrubbing. When you create sequences with multiple effects or layered tracks, 
Avid suggests that you consolidate the media to a local drive instead of working directly 
from the optical disk to avoid dropped frames and to avoid slow response time.

➤ Bug Number: . Link to AMA File(s): This menu choice has been created to be used with 
future third-party AMA file based media plug-ins. To see the available AMA plug-ins 
available for your Avid editing applications, go to www.avid.com/ama/. This option will be 
grayed out if you do not have the appropriate plug-in installed on your system.

➤ Bug Number: . AMA and additional XDCAM Metadata columns: Avid supports new 
XDCAM ID and Data metadata which displays in the Avid bin columns. The metadata is 
available from the DISCMETA.XML file. Additional metadata information has also been 
added when using the Sony PDZ-1 workflow. Depending on the fields you enter information 
to in Sony's browsing software and on the options you choose in AMA, the metadata 
information displays in Avid bin columns and as the volume or bin name.

➤ Bug Number: . AMA and JVC: JVC SDHC volumes are not automatically detected and 
mounted by AMA. Sony's AMA XDCAM-EX plug-in currently detects Sony's SxS folder 
structure, but does not yet detect the JVC SDHC folder structure. A workaround is to use the 
“File > Link to AMA Volume(s)” menu option and then navigate to the 
/PRIVATE/JVC/BPAV folder on the SDHC card.

Avid is working with Sony to allow for the AMA XDCAM EX plug-in to automatically 
detect this folder structure.

➤ Bug Number: . At this time, the Dynamic Relink option is not available with AMA clips.

➤ Bug Number: UDevC00119182.  When you use the AMA method, additional metadata 
column headings disappear when you use custom bin views. There are different scenarios 
when this issue might occur.
They include: When you use the AMA method to link to media and then switch back to an 
already existing custom bin view created before using the AMA feature, the additional 
metadata columns disappear. We've also seen a similar situation if you create a P2 bin and 
link with AMA. Create a customize bin view. All default columns and additional metadata 
columns display. If you then create an XDCAM bin and link with AMA, and then create 
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another customized bin view. All default columns and additional metadata columns display 
as well. When you switch back to the first P2 customized bin view, the additional metadata 
columns disappear. 

Workaround:  When using AMA, Avid recommends that you do not create custom bin 
views. Use the default preset bin views.

➤ Bug Number: UDevC00120470. When linking clips through AMA, the metadata 
information might be missing when you switch from Brief view to Text view in a new bin.

Workaround:  Link the clips through AMA when the bin is in Text, Script, or Frame view. 

➤ Bug Number: UDevC00120055. The Avid editing system might be slow to respond while 
mounting multiple workspaces, while in the application, in AMA (Avid Media Access). 

Workaround:  Mount the multiple workspaces prior to opening the Avid editing 
application, and then work in AMA. 

➤ Bug Number: UDevC00119615.  (Macintosh only) Offline clips appear selected 
(highlighted yellow) even after you eject a write-protected XDCAM EX (SxS) card.

Workaround:  Do not write-protect the card and do not eject the card while the application 
is running.

➤ Bug Number: UDevC00115894. Playing back XDCAM DV 25 media from a disc might 
drop or skip audio frames, this could be due to the disc needing time to spin back up.

➤ Bug Number: UDevC00116263. The following folder names: “OMFI MediaFiles,” “Avid 
MediaFiles,” “Contents,” “Clip,” and “BPAV” are application or camera generated file 
names which contain data appropriate media files. To avoid assertion failure errors when 
mounting volumes, do not create additional folders with these file names on your system. 

Audio

➤ Bug Number: UDEV00220668. If your system is an HP xw8400, you must customize the 
sound configuration in order for the editing application to correctly control the levels of the 
microphone or other connected audio device:

Workaround:  To customize the sound card configuration:

1. In the Project window, click the Settings tab.

2. Double-click Sound Card Configuration.
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3. Ensure that the Record/Input descriptions match the Playback/Output settings. For 
example, if you have a microphone plugged into the rear pink connector, then the 
Playback/Output option should be set to Rear Pink In. If you have a Line input audio 
device connected to the front black connector, the Playback/Output option should be set 
to Front Black In.

➤ Bug Number: UDEV00143962. Clip Pan: When you add an audio dissolve between two 
clips with Clip Pan onto a single audio track, the audio dissolve uses the Clip Pan setting on 
the outgoing source for the duration of the dissolve.

➤ Bug Number: UDevC00118578. Occasionally, you might receive a “ReadStreamAsyn” 
error when performing a Digital Audio Scrub. If you continue scrubbing, the audio will 
come back.

➤ Bug Number: . Pan Automation (overrides Clip Pan when applied): When you add an audio 
dissolve between two clips with Automation Pan onto a single audio track, the audio 
dissolve interpolates the pan values between the pan keyframe value at the beginning of the 
dissolve and the pan keyframe value at the end of the dissolve. Any pan keyframe that exists 
in the middle of the dissolve is ignored.

Workaround:  Place the two clips on separate tracks using Clip Pan, fade one to silence, 
and fade the other up from silence.

➤ Bug Number: . The following procedure causes a failure in the audio output: Open a 
720p50 HD project, open the Capture tool and select HD-SDI video and Audio input. 
Capture an HD Clip from Satellite source using HD-SDI Embedded feature and save it to a 
Bin. Create an HD sequence using the above saved HD clip. Configure the Panasonic HD 
150, and set the deck to accept HD-SDI audio Embedded. Open the Video output dialog. 
Turn on HD-SDI Audio Embedded. Attempting to output an HD sequence (Preview) to an 
HD deck using HD-SDI audio Embedded feature completely fails. There is no audio output 
signal seen on Deck.

➤ Bug Number: UDEV00207753. The Panasonic HD150 deck will not decode the HD 
embedded audio stream from Adrenaline or Avid Nitris.

Workaround:  Connect AES audio from the Avid DNA hardware to the deck and disable 
the embedded audio.

Audio Punch-In Tool

➤ Bug Number: UDEV00086862. You could monitor input during preroll in previous 
versions. If you have a software-only system, you can still monitor input during preroll. If 
you have an Avid Mojo, input monitoring begins at the IN point, not during preroll.
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Avid Unity

➤ Bug Number: UDevCC00080420. Avid Unity MediaNetwork and Power User login: If you 
log into your Windows system as a Power User and use the same login in the Connection 
Manager to log onto Avid Unity MediaNetwork, you cannot play media.

Workaround:  In order to use an Avid editing application in Interplay you must log in as a 
Power User. However, do not use the same login when you use the Connection Manager to 
log onto Avid Unity MediaNetwork. Use a different login for the Connection Manager. This 
problem does not exist on Avid Unity ISIS.

➤ Bug Number: UDevC00089671. Workspace names in Asian characters might appear 
truncated at the end in any drive-selection list.

Workaround:  Use no more than 5 characters for workspace names.

➤ Bug Number: UDEVC00089275. Changing Users on MediaNetwork Fibre attached 
clients: When you change users on a fibre attached client, do not use the Switch User 
function in the Windows Log Off dialog box. When you log back in as the original user you 
may get the following errors when you play media: “Exception: FILE_OTHER, filename… 
Exception: SYS_ERROR, status:1317, msg:The specified user does not exist.” 

Workaround:  To fix the problem once it occurs, reboot the system. To avoid the problem, 
before you switch users, log off completely and reboot the system.

Capture

➤ Bug Number: UDevC00126440.  A/V passthrough sync is not guaranteed while capturing 
HDV material through FireWire devices. The captured media is in sync. 

➤ Bug Number: UDevC00117699.  When performing captures over FireWire with the 
SonyZ7U or Canon XH-G1 camera, you might receive “Lack of progress” errors. 

➤ Bug Number: UDevC00094480. If you have problems with batch capture accuracy for 
footage captured over 1394 due to undetected small timecode breaks, select the “Enable 
detection of small timecode break” option located in the Capture Settings DV& HDV tab.

➤ Bug Number: UDevC00116442.  A 1:1 10-bit capture might fail with 
DIG_VDM_OVERRUN or video overrun errors. This might not occur if storage 
performance is optimized.

➤ Bug Number: UDevC00080115. (Macintosh) You might receive a “Mac Error - 37” error 
when accessing a target drive or workspace with 28 or more characters.
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Workaround:  Make sure the target drive or workspace names have fewer than 28 
characters.

➤ Bug Number: UdevC00025851, UdevC00049993. If you capture clips with an Avid editing 
system on two or more days and use the same project and the same tape name (for example, 
if you capture on two separate days from a cable feed named “Live”), relinking the clips 
might cause the old clips to relink to the new clips. Because the clips in this instance are 
captured on different days but use the same 24-hour timecode and have the same tape name, 
the Avid system treats the captured material as coming from the same source. When you 
relink the clips, they relink incorrectly.

Workaround:  Avid recommends that you avoid using generic or nondescriptive tape names 
— for example, do not use the tape name “Live” for a live feed. Instead, use distinctive tape 
names for each capture. Also, you can use separate projects when capturing with your 
editing system. When you change projects, even if you use the same tape name for your 
captures the Avid system generates new source IDs. This prevents the relink problem.

➤ Bug Number: UDevC26084. If you are working with DV tapes in the Sony HVR-M10U 
you might experience “failed to find preroll errors.”

Workaround:  Change the machine template to the “Generic_DVDevice-NTSC” or 
“Generic_DVDevice-PAL” template. This forces the software to use a different method for 
cueing to the preroll timecode.

➤ Bug Number: UDEV00225379. The editing application does not warn you if you try to 
send a Frame Chase editing clip to Media Services Transcode. Do not send ingesting clips to 
Media Services Transcode. Wait until the clip is completely ingested.

➤ Bug Number: UDevC00086768. You might see the following error message when loading 
a clip captured by Frame Chase capture in the editor: “Error encountered during relink 
process: New track length does not equal original track length.”

Workaround:  In the editing application, right-click the clip and sequence and select 
Update from Interplay. In Assist, refresh the clip from the Interplay database by selecting the 
clip and pressing F5.

➤ Bug Number: UDEV00195662. When you are capturing and using the passthrough 
monitor, desktop passthrough might cover error messages that are in the same space as the 
passthrough monitor, preventing you from being able to read them.

Workaround:  Move the affected window or message box away from the Record monitor, 
put another application in front of the Avid application, and then go back to Avid to force the 
UI to refresh. 
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➤ Bug Number: UDEV00220761. When you capture from an HDV device through 1394 into 
an HDV interlaced project, you might see the video break up into squares. The captured 
media is intact and complete, however.

➤ Bug Number: UDEV00197055. When you capture media that includes invalid frames, you 
might see an error message that the capture has been aborted and the invalid frames 
discarded and it asks you if you want to keep the clip. This message is incorrect; the invalid 
frames have not been discarded.

Workaround:  Click No to discard the clip, and then recapture using new marks that 
exclude the bad sections on the tape. Do not keep the clip.

➤ Bug Number: UDEV00204777. When you deselect Enable Confidence View in the Video 
Display Settings dialog box and then open the Capture tool, the Client monitor does not 
display passthrough.

Workaround:  Do one of the following:

t Select Enable Confidence View.

t Click the Capture button in the Capture tool.

➤ Bug Number: UDEV00184515. In an HDV project, you can only capture audio at the 48k 
sample rate. Because the incoming audio is digital over FireWire®, the software is unable to 
up-sample 32k and 44.1k audio reliably during capture. If you try to capture audio at another 
sample rate, you do not receive the error message warning that the audio on the tape does not 
match the setting in the Audio Project Settings dialog. Currently, only the 48k sample rate is 
supported in the HDV project format.

➤ Bug Number: . If you lose connection to your 1394 port or receive “OHCI Port Busy” 
errors, check the FireWire cable length. 

➤ Bug Number: . When you capture HDV, the system might not find the preroll point if the 
Preroll setting is set to 3 or below. The default is set to 6. Do not set this option to 3 or below.

➤ Bug Number: UDEV00183907. (HDV) Passthrough does not work if Delay Audio is set to 
7 frames or greater. (The Delay Audio option appears in the Capture tool.)

Workaround:  Set Delay Audio to 6 or fewer.

➤ Bug Number: UDEV00181815. Drop frame/Non-drop frame mismatch errors occurred 
often when capturing. A new Deck Preference setting has been added. Access the Deck 
Preferences Settings dialog box. A new “When the deck contains no tape Log as” option 
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appears. Select the timecode format (Drop Frame or Non-drop Frame) for logging clips 
when no tape is in the deck. When a tape is in the deck, the system automatically uses the 
existing timecode format on the tape.

➤ Bug Number: . (HDV) When switching from one project format to another while connected 
to an HDV device, you must turn the HDV device off and then turn it back on again. 

➤ Bug Number: . (Windows) If after initially setting up a DV deck for the first time, or after a 
system recovery you cannot see the deck, manually register the DV buffers file by doing the 
following:

Workaround:  

Perform the following:

1. Go to Program Files\Common Files\Avid.

2. Right click Dvbuffers.ax.

3. Select Open.

4. Choose to select the program from a list and click OK.

5. Browse to windows/system32.

6. Select regsvr32.exe.

➤ Bug Number: UDEV00145432. The following error message appears if you attempt to 
capture DV 25 from a DV 50 source or DV 50 from a DV 25 source: “Exception: 
ADM_DIO_ERROR_OCCURRED, DIOerr:Expected DV50 NTSC but received 
DV25NTSC.” 

➤ Bug Number: UDEV00139553. When you batch capture long clips with a lot of metadata, 
the following error appears and no media is captured: “Exception: 
MXFDomain::SaveMetaDataToFile - Failed to save meta data to file.” This does not occur 
when you batch capture OMF.

➤ Bug Number: . When you capture from a Panasonic AJ-SD93P or Panasonic AJ-SD93E, 
note the following: the Panasonic default for DIF SPEED is set to S400. The Adrenaline and 
Avid Mojo expect a DIF SPEED of S100. Capture fails, producing scrambled or blocky 
images.

Workaround:  From the Panasonic DVCPRO deck's menu, set the menu DIF SPEED to 
S100.

➤ Bug Number: . When you capture DVCPRO HD from a Panasonic HD 1200A deck, keep 
the menu DIF SPEED set to S400.
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Compatibility

➤ Bug Number: UDevC00129804. The list of available transcode resolutions in the Transfer 
Settings list is not accurate. Some of the resolutions listed might be incompatible with the 
current project’s media resolutions.

➤ Bug Number: UDevC00125617. Ancillary Data and Nitris DX: Due to software DNx 
codec performance requirements, you must have a dual quad core system in order to capture 
DNxHD 220 or 220x with ancillary data on the Nitris DX platform. If your system does not 
meet the system requirements, the only way to capture DNxHD 220 or 220x is to make sure 
that ancillary data is not enabled.

To switch the ancillary data feature on and off:

1. 1. Select Tools > Console.

2. 2. Type the following command: Embeddnxcc

OR

In the Media Creation Settings Capture tab, deselect Ancillary Data Enabled.

➤ Bug Number: UDevC00121033. Playing back EVS media on a Symphony Nitris (classic) 
is not supported. Playback is supported for Symphony Nitris DX.

➤ Bug Number: UDevC00110632. (Windows) If you are running a Digidesign audio device, 
such as the Mbox 2, with the editing application and that device appears to be inactive:

Perform the following:

1. Quit the editing application.

2. Run the Digidesign Audio Drivers Installer Program in the Avid Utilities folder.

3. Reboot the system.

4. If the audio device is still inactive, access C:\Program 
Files\Digidesign\Drivers\DigiDriver.exe and select “Install.”

For Windows Vista 64, the location is C:\Program 
Files(x86)\Digidesign\Drivers\DigiDriver.exe.

➤ Bug Number: UDevC00100881.  You cannot connect to a Sony e-VTR device when using 
e-VTR manager on a Microsoft Windows Vista32 or Windows Vista64 systems. The Sony 
e-VTR logging application does not support Vista. 
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➤ Bug Number: UDevC00119004. Previously, the Best Performance Video Quality option 
(yellow/yellow) was the only option available when working with HD projects in 
MultiCamera Mode. The yellow/green video quality option is now available in MultiCamera 
Mode when working with HD projects. 

➤ Bug Number: UDevC00112765. Currently, it might take longer to load a long-GOP 9-way 
or Quad Split source view.

➤ Bug Number: UDevC00105849. If you open the AudioSuite tool when unlicensed plug-ins 
are installed, the system will lock up. 

Workaround:  Either remove the demo or unlicensed plug-in from your system, or connect 
the iLok dongle that has the valid license key to the system.

➤ Bug Number: UDevC00104160, 00024645. If your original project was a 1080i50 or 
1080p25 project, when you are working in a 25i PAL project, the bin headings for MPEG 30 
and MPEG 50 might not be accurate. 

➤ Bug Number: UdevC00102207. (Macintosh) If you find that your mapped F keys are not 
working, go to System Preferences > Mouse and Keyboard > Keyboard tab and make sure 
“Use F1-F12 keys to control software features” is checked.

➤ Bug Number: 99387. Currently, if you are exporting a QuickTime movie and select the 
Custom option, you might receive an Access Violation and a Structured Exception loop 
dialog. You must force quit the application or select Abort on the Structured Exception 
dialog box. In QuickTime player, go to Edit > Preferences > QuickTime Preferences, then 
select the Advanced tab and select “Safe mode (GDI only)” under video.

➤ Bug Number: UDevC00098170,UDevC00098065. If you are working on a 
standard-definition (SD) project with an Avid Nitris DX or Avid Mojo DX attached to your 
system, you cannot use the Best Performance mode for video playback. If you open an SD 
project created on a system with an Avid Adrenaline attached and utilize Best Performance 
mode, the Avid Nitris DX system promotes the video quality to Draft Quality. Either click 
the Video Quality button and select Draft Quality or Full Quality, or change the project type 
to the appropriate high-definition format.

➤ Bug Number: UDevC00101326. Currently, if you export a QuickTime movie and convert 
the sample rate on export, it might result in bad audio.

➤ Bug Number: Udevc00101033.  (Adrenaline, Windows Vista) If you are running your 
editing application on the xw8400 or xw8600 computer you must have the HP 1394a 
FireWire card (Avid PN 7030-20154-01; HP PN PA997A) or the Sonnet Technologies™ 
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Allegro™ FW400 1394a FireWire card installed. You may experience “Huffman Decode” 
errors during batch capture or capture on-the-fly if you run with an unapproved Firewire 
card.

➤ Bug Number: UDevC00097564. Currently, if you are on a Windows Vista 64 editing 
application and you try to open a bin that was created on a Windows XP editing application, 
you might receive an “Unable to open file” message. The issue is that when you move a file 
from the desktop to the project folder, it loses access rights. Access the file as an 
administrator and add Authenticate Users with Full Control.

➤ Bug Number: UDevC00093513. (Macintosh) The editing application might not launch if 
your system volume name contains "/" . Make sure the computer volume name does not 
include a “/”.

➤ Bug Number: UDevC00090317. A non-Administrator cannot send or receive EDLs. You 
must be an administrator to use EDL Manager.

➤ Bug Number: UDevC00079997. (FilmScribe) The Tape Name does not appear in a cut list 
when you select the TapeID column heading.

Workaround:  If you select both the Reel# and TapeID column heading, the Tape Name 
appears.

➤ Bug Number: . (Macintosh) When you are using the search feature in the Avid editing 
application Help, a bug exists if Safari™ is your default browser. You might experience 
issues when performing searches. You need to empty the Safari cache in between searches 
(Select Safari > Empty Cache.) This search issue does not occur when you use Firefox™ as 
your browser.

➤ Bug Number: UdevC00007737. If you are using an Mbox 2 and an HP8400 computer, you 
should connect the Mbox 2 to a rear USB port. The USB ports on the front of the HP8400 
can cause problems with the Digidesign Driver Installer. Once the installation is complete, 
you can connect the Mbox 2 to the front or rear USB ports.

➤ Bug Number: UDEV00140811, UDEV00140767, UDEV0221008. If you are using the 
Safari browser to access the Avid Learning Excellerator™ site (select Help > Learning 
Resources, and then click the Avid Learning Excellerator link), you must have Javascript® 
and cookies enabled (Safari > Preferences > Security).

➤ Bug Number: UDevC00052206. Due to changes in Avid Media Composer v2.5.x 
(Macintosh), some third party AudioSuite and AVX plug-ins may not load properly. This is 
due to moving the Avid editors to Xcode® from CodeWarrior™ 9 for support of the new 
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Mac Intel® based systems. Customers may need to upgrade their AudioSuite and AVX 
plug-ins. Please note that Avid has informed Third Party partners of this change. Third Party 
plug-ins that have not been updated will not be supported in this release.

➤ Bug Number: UDevC00079523. If you are a non-administrator and you want to launch 
AudioSuite Plug-Ins, make sure you have an administrator make you a member of the 
AvidUsers group which is automatically created during installation. 

➤ Bug Number: UDEV00219672. You currently cannot select HDV projects in the 
MediaLog™ application.

➤ Bug Number: UDEV00164891. (NewsCutter Software Only) When working with the 
HP/Compaq nw8000 laptop, if you press the volume button (which is located on the front of 
the laptop, not on the keyboard), this causes an overwrite in the source/record edit to the 
Timeline.

➤ Bug Number: UDEV00141328. Sending to Digidesign® Pro Tools: When you export an 
OMF 2.0 file that links to MXF media, you should first transcode the MXF Media to OMF 
media. If you have a long sequence containing MXF media, you are not prompted prior to 
the export process that the export will not be successful. To save time, transcode MXF media 
to OMF media prior to exporting as OMF 2.0.

➤ Bug Number: UDevC00091387. Due to an issue with the RICOH FireWire controller on 
the Dell M65 and M90 laptops, when playing out to the host in 1394 mode, as well as a DV 
device via the “Output to DV Device” option, video and audio may drift out of sync.

Workaround:  Turn off “Output to DV Device.” Or, if you have to use the DV Device for 
monitoring, connect the speakers or headphones to the DV device/camera instead of the PC.

➤ Bug Number: UDevC00120475. Editing keyboard shortcuts such as Ctrl+X and Ctrl+C do 
not work in MetaSync Manager. Use the menu commands.

Digital Cut

➤ Bug Number: UDevC00102676. When performing a digital cut, you will receive the 
message “If you have a genlock signal connected to your BOB, please switch it to match the 
output rate. Use an appropriate black burst sync source. Then wait for the REF light on the 
BOB to turn green and press Continue.” If the light turns green, press Continue and the 
digital cut will be performed. If not, make sure an appropriate sync source is connected and 
wait for the REF light to turn green.
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➤ Bug Number: UDevC00097111.  (Avid Nitris DX/Avid Mojo DX) Currently the blue bar in 
the Timeline might not reach the end of the sequence at the end of a digital cut. All frames 
are actually cut to tape. 

➤ Bug Number: UDevC00118267.  A “Media Offline in Composition” error might occur 
with a Digital Cut even when all media is online. Select Continue to perform the Digital Cut.

➤ Bug Number: UDEV00222537. (Macintosh) When performing a 720p/59.94 digital cut, 
the first frame of the sequence might be missing.

Workaround:  Add half a second of black before the sequence.

➤ Bug Number: UDEV00220887. The first 35 frames of a sequence might be missing when 
you perform a digital cut after selecting Crash Record and Ignore Time in the Digital Cut 
tool.

Workaround:  Add filler to the beginning of the sequence.

➤ Bug Number: UDEV01845957. When performing an HDV digital cut, the last few seconds 
are not cut to tape.

Workaround:  Generate a clip of black and add it to the end of the sequence.

➤ Bug Number: UDEV00174311. A digital cut of an HD project might drop the last frames 
of audio.

Workaround:  Add 10 frames of audio to the end of the sequence.

➤ Bug Number: UDEV00135921. When you perform a digital cut using the Pioneer® 
PRV-LX1 DVD recorder, select Ignore Time in the Digital Cut Tool window.

➤ Bug Number: UDEV00136395. A video underrun might occur at the start of a digital cut if 
the Digital Cut tool does not have focus when you click the Play Digital cut button. The 
Digital Cut tool must be active before you click either the Start or Preview button. If an 
underrun occurs at the very start of the digital cut, you should be able to perform the digital 
cut without a problem.

➤ Bug Number: UDEV00139484. When you perform a digital cut to a Panasonic DVCPRO 
HD deck using HD-SDI with 720p/59.94 material, several frames of black might be written 
to tape before the start of the outputted sequence. This might result in the end of the 
sequence being truncated on tape.

Workaround:  Place several seconds of black or color bars at the end of a sequence.
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➤ Bug Number: UDEV00138162. The Digital Cut tool does not allow certain durations of 
black to be added to the tail of a sequence. Certain values (including 20 minutes, 30 minutes, 
60 minutes, and so on) reset the clock to zero when applied. If the value you entered resets to 
zero when applied, adjust the value upward or downward until a satisfactory length is 
determined (at which point the clock does not reset itself and the desired duration is 
correctly applied).

Dynamic Relink

➤ Bug Number: 103557. Any MPEG2 352_30I MXF media created with an x.8.1 or x.8.3 
editing application will not relink in Exact match in versions x.8.4 of the editing applications 
or the Media Composer 3.0 or Symphony 3.0 or NewsCutter 7.0 versions of the editing 
application. The MPEG2 352_30I MXF media created with an x.8.1 or x.8.3 was 
compressed at 15MB instead of 2MB and therefore will not relink in Exact match. 

Workaround:  Change the Dynamic Relink settings to use the “Most compressed” option 
or change the “If no match is found” option to “Relink to Closest.”

➤ Bug Number: UDEV00225796. When working with HDV projects, HDV resolutions are 
not available for Dynamic Relink. 

Workaround:  Choose “Use Closest Media” instead of “Relink to Offline” when in HDV 
projects and “Specific Resolution” is selected as the Relink Method. If you do not choose 
“Use Closest Media,” captured clips appear as offline when Dynamic Relink is enabled.

➤ Bug Number: UDEV00221144. If you want to re-create title media at a target format other 
than the working format, you must change the project format to that designated for the 
target. Otherwise only the working format resolutions are available.

Effects

➤ Bug Number: UDevC00118276. You might experience dropped frames on the initial 
playback of a sequence containing a Pan and Scan effect. 

Workaround:  Set the Image Interpolation option in the Render Settings to Standard 
(Bilinear).

➤ Bug Number: UDevC00112035. You might receive a bus error when exporting a sequence 
in a 24p NTSC project that contains a scratch removal effect. Render the sequence first.

➤ Bug Number: UDevC00117131. Currently, you cannot preview Multi channel audio clips 
with AudioSuite Dynamic 3 plug-in effects. The plug-ins work in the Timeline.
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➤ Bug Number: UdevC00117990. If you try to conform an AFE created from the Avid Media 
Composer or Avid Symphony editing application to Avid DS, the Color Correction 
animation effects will not conform. The effects will be replaced with a wipe effect. You 
should demote the color corrections. Right-click the sequence that contains the Color 
Correction effects and select Demote Effects. This creates a a duplicate sequence that you 
can open in Avid DS.

➤ Bug Number: UDevC00114633. When you apply a SubCap or TimeCode Burn-In effect to 
a clip with the Effect Editor set to Thumbwheels, the first few characters in the text field are 
cropped from view. They do appear properly on the image.

➤ Bug Number: UDevC00113832. Applying Boris Continuum Complete deinterlace above 
other effects might corrupt the image.

➤ Bug Number: UDevC00115301. You might receive an “AudioSuite DAE” error when you 
render a master clip with a ReelTape AudioSuite Plug-in. The error does not occur if you 
render in the Timeline. 

➤ Bug Number: UDevC00118588. The Tracking window becomes deselected after switching 
from a nested effect to the top-most effect. You must close and then reopen the Tracking 
window to make it available.

➤ Bug Number: UDevC00118505 . Currently, a Superimpose or Dissolve effect does not 
promote to 3D Warp.

Workaround:  First promote to Advanced Keyframe, then to 3D Warp.

➤ Bug Number: UDevC00109451.  When the Color Correction window is open, Loop Play 
will include the sequence, not just the current clip, even if the Effect Editor is open.

➤ Bug Number: UDevC00120950. You might experience dropped frames when playing back 
an HD sequence containing a Safe Color limiter effect with the “422 Safe” option selected.

➤ Bug Number: UDevC00113368. When working in 3D Advanced keyframes, occasionally, 
keyframe points might not display in the path.

Workaround:  Click the Enlarge or Reduce button located below the Effect Preview 
Monitor.

➤ Bug Number: UDevC00106944. In a 1080i59 project, effects that invert or resize the image 
might appear field-reversed during play in an SD timeline.

Workaround:  Transcode the media to SD.
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➤ Bug Number: UDevC00097157. A clip with an unrendered TimeWarp effect might not 
import to Pro Tools. Render the effect before exporting.

➤ Bug Number: UDevC00090708. When you try to run AudioSuite you might receive the 
following message, “Your computer is missing a Windows XP update required by ProTools. 
Please install all available critical updates before installing Pro Tools.” If you do, you must 
perform a Windows Update, Custom Install to ensure the correct .dll is installed.

➤ Bug Number: UDevC00003573. While in Effect mode, you might not be able to scrub 
through blue dot effects and have the monitor update. Move the Effect Editor so that it 
overlaps some part of the Composer monitor. The monitor should now update correctly 
when you scrub through blue dot effects.

➤ Bug Number: UDEV00225614. Safe Color limits might be exceeded in SD downconverted 
output from an HD project. In an HD project, if you use the Safe Color Limiter effect to 
ensure safe colors in a sequence and then output that sequence using SD downconvert, some 
transient pixel values might exceed your safe color ranges. This is a consequence of the 
resizing process performed in the Avid Nitris or Adrenaline hardware during an SD 
downconvert.

Workaround:  Change the project type to an SD type before you output or render the 
sequence.

➤ Bug Number: UDEV00219374. In 30i or 1080i60 projects, Timewarp effects that use the 
Film With 2:3 Pulldown Input format might not render correctly. Some frames might remain 
unrendered or it might not be possible to complete the render. This problem is known to 
occur in the specific circumstances described below, but might also occur in other 
circumstances.

Partial Render. The problem might occur if you perform a partial render of a Timewarp 
effect using the Film With 2:3 Pulldown Input format, then render the remaining part of the 
segment. Some frames might remain unrendered or the second part of the segment might not 
render.

Division of rendered segment. The problem might occur if you render an entire Timewarp 
effect using the Film With 2:3 Pulldown Input format, and then divide the segment (for 
example, by performing an overwrite edit of new material into the middle of the segment). 
Some frames in the second part of the divided segment might become unrendered.

Trimming head frame of rendered segment. The problem might occur if you render an entire 
Timewarp effect using the Film With 2:3 Pulldown Input format, and then trim the head 
frame of the segment. Some frames in the segment might become unrendered.



  

46

➤ Bug Number: UDEV00207851. You might not be able to render a FluidBlur, 
FluidColorMap, or FluidMorph effect in an HD project if there is not enough memory 
available.

Workaround:  Try one of the following:

t In the Bins tab of the Project window, click the Clear button, and render the Fluid effect 
(see “Managing Bins and Memory” in the Help).

t Close all unused bins, relaunch, and render the Fluid effect.

t In the Format tab of the Project window, switch the project format to an SD format, 
render the Fluid effect, then switch back to HD.

➤ Bug Number: UDEV00221706. Very high speed Motion Effects with rates greater than 
500% no longer play in real time; they now appear in the Timeline as a blue dot effect, and 
must be rendered. Since any motion effect with a rate greater than 100% plays back 
inefficiently, and the higher the rate the less efficiently it plays back, real time playback 
efficiency will improve by rendering such motion effects.

➤ Bug Number: . (HDV) If a clip contains Timewarp effects, you should render the effects.

➤ Bug Number: . You might experience effects render issues with stacked effects.

Workaround:  Render each individual track starting with the bottom track.

➤ Bug Number: UDEV00197962 . When you are working with AVX effects, performing an 
Expert Render or a Render IN to OUT on a sequence that contains multiple third-party AVX 
effects might lead to excessive memory consumption that could cause the application to 
hang or to display errors.

Workaround:  Render the effects in smaller groups.

➤ Bug Number: UDEV00214545. AVX 1.0 effects might have invalid color levels.

➤ Bug Number: UDEV00194693. You might see problems with superblacks in 16-bit mode.

➤ Bug Number: UDEV00189486. Performing an Add Edit on a promoted Advanced 
Keyframe Picture-in-Picture effect might cause a “DataPointOneError.”

Workaround:  Instead of first promoting to 3D, then Advanced Keyframe, promote in the 
reverse order.
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➤ Bug Number: UDEV00132940 . You might see a “FluidMotion Vector Edit Requires Full 
Resolution” error if you work in FluidMotion™ Vector Edit mode in anything other than full 
resolution (green mode in the Timeline). Render FluidMotion effects before you combine 
them with any other effects, especially any other time-based effects.

➤ Bug Number: . (Progressive projects only) If a clip contains any of the following effects, 
you must render the effects before you apply Scratch Removal:

• Timewarp effects 

• Any effect that has been promoted to the Advanced Keyframe model

➤ Bug Number: UDEV00134286. Removing or undoing some timewarp effects might cause 
audio and video to lose sync.

➤ Bug Number: UDEV00161774 . In the Transition Corner Display mode, two of the six 
frames display incorrect frames during trim operations initiated from the Timeline.

Workaround:  Trim using the Trim buttons.

➤ Bug Number: UDEV00144549. The Fluid film 2:3 timewarp effect might render 
incorrectly when you are rendering fluid motion type. The effect might flash a crop of left 
and right edges.

Workaround:  Set the left and right mask in the FluidMotion Editor to zero.

➤ Bug Number: UDEV00164929. (HD only) Any animated alpha matte over 35 seconds long 
might fail.

➤ Bug Number: UDEV00163592. When an Avid effect is applied in an SD 24p progressive 
project, it can create unwanted aliasing on the resulting clip.

Effects (Pan & Zoom)

You might encounter the following limitations when you use the Pan & Zoom effect:

➤ Bug Number: UDevC00119611. If you run out of memory when using Pan & Zoom, resize 
the images to a lower resolution using an application such as Adobe Photoshop software.

➤ Bug Number: UDevC00088408. (Macintosh) After the link to a Pan & Zoom effect is 
broken and you want to reestablish it, the application doesn’t prompt you for the source 
image name in the Open dialog box.
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Workaround:  Import still images into a bin and use them in the edit. With the imported 
image in the Timeline, apply the Pan & Zoom effect and load the respective file from the 
Open dialog box. This way you can use “Clip Text” and confirm that the correct images are 
being loaded.

➤ Bug Number: UDevC00088408. (Macintosh) After the link to a Pan & Zoom effect is 
broken and you want to reestablish it, the application doesn’t prompt you for the source 
image name in the Open dialog box.

➤ Bug Number: UDevC00081281 . Pan & Zoom keyframe settings can revert to defaults if 
you select all keyframes when you link to a new picture.

➤ Bug Number: UDevC00025291. When you zoom in with Hi Qual and Ultra Qual filtering, 
you might experience a system error (Windows) or see green lines when you preview 
(Macintosh).

➤ Bug Number: UDevC00090139. To improve memory issues, the options in the Pan & 
Zoom Cache Fast menu are ignored and Video Resolution is used, although when you render 
the effect, the highest-quality resolution is always used. After you partially render a Pan & 
Zoom effect, however, you might see a slight pixel shift when you move between the 
rendered and unrendered portions.

Export

➤ Bug Number: UDevC00112498. QuickTime Movie export fails when using the Qualcomm 
PureVoice audio compressor. 

➤ Bug Number: UDevC00117134. (Mac Intel) You might have received “image buffer” 
errors when exporting to DNxHD in Adobe After Effects® 7. This error does not occur with 
After Effects CS3 or CS4.

➤ Bug Number: UDevC00106032. (Macintosh) Exporting HDV files to the desktop results in 
a 0 k file on the desktop. The file will actually appear in your Macintosh User folder. If you 
export to a folder, note that the file will actually be created one folder level above.

➤ Bug Number: UDevC00090871. (Macintosh) When sending a QuickTime Reference to 
Sorenson Squeeze, Auto Load and Reveal Files do not work. Squeeze will launch, but the 
sequence does not load nor are the files revealed in the Finder window.

Workaround:  Manually import the files into Sorensen Squeeze.

➤ Bug Number: UDevC00098849, 103011. (Macintosh) If you try to export to a read only 
drive you may get an exception. Ensure you are exporting to a writable drive.



Limitations and Known Issues

49

➤ Bug Number: UDevC00102078, 101999. Export to HDV Device will fail on a Windows 
system if your sequence contains native HDV media (HDV media captured from tape). This 
does not apply to Macintosh systems.

Workaround:  Transcode to another resolution before performing the export.

➤ Bug Number: UDevC00081152. An error might occur when you export to HDV when the 
first frame of the sequence is a video mixdown clip.

Workaround:  Place filler or a frame of non-video mixdown media at the head of the 
sequence.

➤ Bug Number: UDevC00049124. Currently, export settings allow a 720x486 size when you 
export Avid DV, which creates a field alignment issue. Make sure that you set the export 
settings correctly for 720 x 480 for DV exports. Currently, QuickTime must do a resize from 
486 lines down to 480 and you receive an odd interpolation. (Even if you specify 720x486, 
the Quicktime file displays 720x480.)

➤ Bug Number: UdevC00054456. In NTSC, QuickTime Same as Source and QuickTime 
Reference clips containing DV material can sometimes show visual distortions when burned 
to DVD from Avid DVD. This is because the DV portions are resized from the DV raster 
size 720x480 up to the standard NTSC raster size 720x486.

Workaround:  When exporting the QuickTime Same as Source or Quicktime Reference 
clips, choose “Use Avid DV.”

➤ Bug Number: UdevC00007778, UDevC00025957. (Macintosh) The editing application 
might crash after exporting to an Avid Unity ISIS Read-only workspace. Make sure you 
export to a Read/Write workspace. You can determine whether a workspace is Read/Write 
through the Client Manager application. Navigate to the Workspaces tab in Client Manager. 
The Read/Write workspaces are listed with an R/W under the name of the workspace. 

➤ Bug Number: UDevC00078454, UDevC00081066. If you have a mixed-resolution DV 25 
sequence and try to export it as QuickTime for DVD using the Apple DV Codec, the .mov 
might contain artifacts.

Workaround:  You must use the Avid DV Codec for this kind of sequence.

➤ Bug Number: UDEV00180852. You might receive exception errors when exporting HDV 
1080i/59.94 or 1080i 50 as Windows Media.

➤ Bug Number: UDEV00181835. When exporting to an HDV device, at least 4 to 5 seconds 
of media might be missing from the beginning of the sequence.
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Workaround:  Add 10 seconds of color bar or black filler at the beginning and at the end of 
the sequence.

➤ Bug Number: UDEV00140687. When you export a QuickTime Reference movie, do not 
mix DV and non-DV media. If you mix DV and non-DV media, the resulting movie might 
contain line shifts.

➤ Bug Number: UDEV00087119. When you export pan automation on an audio clip as AAF, 
it does not translate in Pro Tools. Pro Tools does not accept varying value pan controls 
during import.

➤ Bug Number: . In the Export Settings dialog box, the default size is not the image size of 
the opened project.

➤ Bug Number: UDEV00086337. When you play an exported clip in the Windows Media 
Player, the sequence stalls in the desktop monitor. The audio plays, the blue bar progresses 
in the Timeline, and the video and audio output to the client monitor is OK. If the clip that is 
loaded in Windows Media Player is removed, then the Play operation plays properly in both 
the desktop and client monitors.

➤ Bug Number: UDEV00138232. Exporting Locators exports only a .txt file with frame 
count information, not timecode or Feet and Frames. Import also supports only frame count.

➤ Bug Number: . (Encoding to Windows Media) A “Not enough memory is available to 
complete this operation or WM_BeginWriting_FAILED” error results from the application 
running out of available memory (RAM) while you perform the encode. Encoding to a 
Windows Media Video codec requires a lot of memory. The amount of memory required is 
directly related to the number of audio and video profile streams, width, height, bit rate, 
number of passes, VBR/CBR, and quality of the encoded video, as well as the resolution of 
the source media. If you encode HD media, you might need to reduce the bit rate, turn on 
2-pass encoding, turn on VBR, lower the quality, or reduce the frame dimension.

➤ Bug Number: . A “WM_FindInputFormat_FAILED” error might appear if the Windows 
Media exporter cannot find a suitable input format for a video or audio stream contained in 
the current Windows Media Export setting's stream profile. For example, using non-standard 
frame dimensions might result in this error. See the Microsoft Windows Media Web site for 
more detail.

ICS (International Character Support)

➤ Bug Number: UDev00089590. Workspace names that contain non-ASCII characters can 
cause poor performance when working in a bin. 
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Workaround:  Use only ASCII characters in workspace names.

➤ Bug Number: UDevC00051974. If you capture a clip from a workspace with a French 
name through CaptureManager™, in the Avid editing application the bin heading Drive 
might be empty where it should list the French name of the workspace.

➤ Bug Number: UDevC00051060,UDevC00088815. If you change the font or font size of 
your input, and see characters rotated 90 degrees, make sure you select the correct font. Do 
not use any font that begins with the “@” symbol.

➤ Bug Number: UDevC00052541. Do not create a project using the Euro currency character 
(ALT 0128). The project fails to be created and a “Can't Open Project” error message is 
displayed.

➤ Bug Number: UDevC00022395, 22346. Certain Asian characters might not appear in the 
correct order in some text boxes in your Avid editing application.

Import

➤ Bug Number: UDevC00049653. Occasionally, if you cancel an import of a clip, you might 
receive a “DISK_SHARING_VIOLATION” error.

➤ Bug Number: UDEV00086727. When you import an uncompressed QuickTime file, a 
PICT image, or a TIFF image, the first 4 or 5 vertical columns of pixels might truncate when 
you display the file in the Source, Record, or client monitors.

➤ Bug Number: UDEV00141372. When you batch import a sequence with a graphic 
animation that was created in a 30i project and then modified in a 720p project, it might not 
import.

Workaround:  Import the graphic and manually edit it back into your sequence.

➤ Bug Number: UDEV00138270. Avid editing systems cannot import AVI files created on 
Avid DS Nitris systems. The import fails with an error message stating that the file format is 
not supported for import.

Installation

➤ Bug Number: UDevC00102551.  (Macintosh) When launching the editing application, and 
the Audio is initializing, “CoreMIDIServer.framwork” might bounce in the dock. It may 
remain in the dock until you quit the editing application.

Workaround:  Delete DigiDioMidDriver.plugin from the Library/Audio/Drivers folder.
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➤ Bug Number: UdevC00106344. After installing the editing application on the Windows 
Vista OS, when you choose to reboot the system, the shutdown cycle is longer than usual. 

➤ Bug Number: UDevC00103563. On Windows platforms, occasionally the PACE installers 
do not properly update the iLok drivers. PACE iLok drivers are used to copy-protect 
Digidesign plug-ins. If this happens, the AudioSuite functionality in Media Composer will 
be disabled. To correct the situation the user should uninstall all instances of Interlok Drivers 
from the Windows Add Remove Control Panel and re-install the Digidesign Drivers from 
the CD or from Avid > Utilities.

➤ Bug Number: UDevC00103537. Once you install the editing application, and once the 
editing application tries to launch, while it is initializing, you might receive an “Unable to 
create index for editor slides” error message. 

Workaround:  Right click the product.exe and choose “Run as administrator.” This causes 
the mdb and pmr files to update in the Avid_MediaFiles folder.The executable is located (by 
default) in C:\Program Files\Avid\Avid Product Name.

➤ Bug Number: UDevC00103474. (Windows Vista) When the editing application is launched 
and a firmware update is required, you might be prompted to relaunch using “Run As 
Administrator”. To run as administrator, right-click the product.exe and select Run as 
administrator. The executable is located (by default) in C:\Program Files\Avid\Avid Product 
Name. Run as administrator is not available by right-clicking in the Avid editing application 
Shortcut icon.

Interplay Workgroup

➤ Bug Number: UDevC00105773. When you create a video or audio mixdown and add a 
locator, you might receive an “Exception: CM_NO_TC” error when you try and check the 
clip in to Avid Interplay. If you add the locator in Assist, then go back to the editing 
application and perform an Update from Interplay on the clip, the clip will check in 
successfully.

➤ Bug Number: UDevC00105408. (Windows Vista) If you have a P2 drive mounted and you 
try to open the Interplay Service Configuration tool, you might receive an Exception error. 
Clicking through the error message might allow you to open the tool. If you unmount the P2 
drive, the tool will open.

➤ Bug Number: . When checking out a complex or long sequence from an Avid Interplay 
environment the following message might appear: “A request for data from the asset 
manager is taking a long time to complete. Would you like to continue waiting for the 
operation to complete or would you like to cancel?” If you choose to wait the sequence may 
load or you may get this message multiple times until the check out actually occurs.
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➤ Bug Number: UDevC00091228. Selecting Check In All Open Bins from the Fast menu 
(hamburger menu) in the bin might not check in the open bins. 

Workaround:  To check in all open bins, select Check In All Open Bins from the File 
menu.

➤ Bug Number: UDevC00090338. After you perform a search for media in the Interplay 
Window, you cannot refresh the search results displayed in the Research panel by pressing 
F5. If you want to refresh the results, repeat the search.

➤ Bug Number: UDEVC00052480. Batch Import of files containing Alpha. This problem 
occurs if you want to batch import files in SD and HD formats and then use Dynamic Relink 
to switch between the different formats. The problem occurs with QuickTime movies, 
graphics, and sequences that contain alpha. You can batch import the files and relink to the 
different formats, but if you exit and then restart the Avid editing application you can no 
longer relink to the HD format. The system displays an “Exception: NO Compressed Data 
Format found” error message.

Workaround:  You cannot use Dynamic Relink with HD and SD clips that contain alpha. 
Import the HD files with alpha as individual clips. When you want to switch to HD format, 
edit the HD versions into your sequence.

➤ Bug Number: UDEV00227044. If you import a graphic from your local drive into a project 
in an Avid editing application, change the original name of the clip to a name of your choice, 
and check that clip into a folder in the Interplay Window, the new name does not appear in 
the Interplay Window even when you refresh the window. You see only the original name.

➤ Bug Number: UDEV00217606. In the Avid editing application, the Record Track monitor 
buttons might be deselected if the following happens:

1. On system1, create a sequence and check it into a folder in the Interplay Window.

2. On system2, check out the sequence and load it into the Timeline.

3. On system1, edit the sequence and check it into the Interplay folder again.

4. On system2, refresh the Interplay window then check out the same sequence again.

Workaround:  Select the Record Track buttons again.

➤ Bug Number: UDEV00299154 . In an Avid editing application, if you have a sequence that 
you have not checked into the Interplay Window and you try to use the Transfer > Send to 
Workgroup command, you might experience an error.
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Workaround:  Check the sequence into the Interplay Window before you attempt to 
transfer it.

➤ Bug Number: UDEV213923 . In workgroup environments prior to Avid Interplay, you 
could automatically consolidate from NewsCutter during Send to DMS. With the Avid 
Interplay release, the automated consolidate is not available. Choose to consolidate prior to 
sending to DMS.

➤ Bug Number: UdevC0055755. When working with MultiRez, high-quality audio cannot be 
distinguished from up-sampled proxy audio created with previous versions of the editor. For 
instance, an 8 kHz proxy audio up-sampled to 48 kHz on import in Interplay version 1.0 is 
considered as good as a real 48 kHz high quality audio. In that case, if MultiRez is set to use 
48 kHz audio, it picks up the most recent of the two files.

Force Disconnect Client Mode in an Interplay Environment

Your system administrator might need to temporarily remove your editing system from 
access to the network. This might occur if new software needs to be installed or if 
components need to be updated, for example. To force a disconnect, your administrator runs 
a script that forces disconnection from the network without physically removing your 
system. Your administrator can also reconnect your system at the appropriate time using 
another script.

It is possible to import from shared drives and export to them in Forced Disconnected Client 
mode. Avid recommends, however, that you do not import from or export to shared drives 
when your administrator has force-disconnected your editing system. Avid does not support 
any workflow that includes importing from or exporting to shared drives when the system is 
in Forced Disconnected Client mode.

In general, if you are in Forced Disconnected Client mode and if you import or export using 
shared drives, after the import or export those drives might appear to be available for other 
purposes such as importing, capturing, playing, or deleting media, but they are not available. 
Similarly, options for shared storage might appear to be available in various settings dialog 
boxes and shared drives and media might appear in various menus, tools, and applications; 
Avid does not support use of these settings, drives, or media.

To remove the shared drives from your drive lists, disconnect your network cables as 
described in “Voluntarily Disconnecting from the Interplay Environment” in the Help, or 
exit your editing application and restart it.

The following limitations describe specific instances of drives and options appearing in 
Forced Disconnected Client mode:
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➤ Bug Number: UDevC00083319 . In the Select Project dialog box, shared workspaces and 
projects are available and should not be.

➤ Bug Number: UDevC00083320,UDevC00083772.  Shared drives and media are available 
in the Media tool and in the MetaSync™ application and should not be.

➤ Bug Number: UDevC00083321. In the Interplay Server Settings dialog box, you can 
change the Interplay server name and you should not be able to.

➤ Bug Number: UDevC00083371 . In the Capture tool, you can select the Interplay Folders 
option as your capture destination and you should not be able to.

➤ Bug Number: UDevC00083374. In the MXF Media Files tab of the Capture Settings dialog 
box, you can select the “During capture, clip is updated in Interplay” option and you should 
not be able to.

➤ Bug Number: UDevC00083477.  In the Temporary File Directory option of the General 
Settings dialog box, you can type the name and location of a shared drive and you should not 
be able to.

➤ Bug Number: UDevC00083409. Shared drives and media are visible in the Hardware tool 
and should not be. 

➤ Bug Number: UDevC00083740. Shared drives are visible in the Import dialog box and 
should not be.

➤ Bug Number: UDevC00083826. Options in the Media Services Settings dialog box are 
available and should not be. 

➤ Bug Number: UDevC00083496. Options in the Transfer Settings dialog box are available 
and should not be. 

➤ Bug Number: UDevC00084455, 84773.  Selecting LANshare, PortServer settings, or 
ProEncode™ appears to be available but should not be. Do not select these options.

➤ Bug Number: UDevC00084446. Dynamic Relink can be enabled but that should not have 
been allowed. Do not enable it. 

➤ Bug Number: UDevC00084600, 84844.  With several of the options in the File menu, you 
are allowed to select a shared workspace as a destination but you should not be able to. Do 
not select a shared workspace in this context.
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➤ Bug Number: UDevC00084610.  If you select Automatic Login at Project Selection in the 
Interplay User Settings dialog box, enter Disconnected Client mode, exit the mode and the 
editing application, reconnect, and then restart the editing application, you need to log into 
Interplay again and you shouldn’t have to.

➤ Bug Number: UDevC00088542.  In Forced Disconnect mode, if you make a change to your 
User settings, the change might appear for all other users, as well.

JVC 

➤ Bug Number: UDevC00106545. JVC recommends using the BR-HD50 deck to capture 
and batch-capture HDV media recorded with JVC cameras.

➤ Bug Number: 106030. The JVC GY-HD250U camera might drift out of sync while 
shooting in 720p/59.94. To avoid this issue, turn on the camera in 720p 23.976 and then 
switch the format to 720p 59.94 causing a soft reboot.

➤ Bug Number: UDevC00106380. The Imported M2T files that were captured with a JVC 
GY-HD250U camera via the FireStore DR-HD100 will show up in the bin with the wrong 
durations. This occurs in 720p 50 and 720p 60 projects.

➤ Bug Number: UdevC00106401. Currently, captured or imported M2T files might contain 
1/2 frame offset. This occurs in 720p 29 and 720p 25 projects.

Locators

➤ Bug Number: UDevC00080303. If you add a locator to a shotlist, and then open the 
sequence in an editing application, the locator appears, but if you perform a match frame on 
the locator, it might not appear in the master clip.

Workaround:  In the editing application, check the master clip in question out of Interplay 
and then update the bin or the clip. The locator appears.

➤ Bug Number: . A new item has been added to the Fast menu in the Locators window. 
“Disable Locator Popup” disables the locator pop-up window. It is disabled only for the 
work session. When you restart the Avid application, the locator pop-up menu is enabled.

➤ Bug Number: UdevC00079172. (Macintosh) When you export locators from the Locator 
tool, the file might not be saved with the correct .txt extension and you might not be able to 
import it.
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Workaround:  In the Choose Location for Exported Locators dialog box, add the file name 
extension .txt to the end of the file name before you click Save, or add the extension to the 
saved file before you import it.

Mixed Frame Rate and Field Motion Types

➤ Bug Number: UDevC00126375. If you are sending a mixed resolution sequence to 
playback, make sure “Same as Source” is unchecked in the Media Creation Settings Render 
dialog box. The render format must match the primary playback format.

➤ Bug Number: UDevC00129278. When you bring a mixed frame rate sequence into Pro 
Tools, make sure the “Ignore rendered audio effects” option in Pro Tools is disabled. If the 
option is selected, the audio for any mixed frame rate clips will be missing from the 
Timeline.

➤ Bug Number:  UDevC00129238. Some motion effects on Long GOP media might display 
as non-realtime effects where in the past they displayed as real-time. This might occur under 
the following conditions.

• The video track of the underlying clip is a spanned clip. For example, a spanned clip is 
one where the master clip originated from an XDCAM EX device, or a master clip that 
has been modified by dynamic relink after an operation such as partial restore. You can 
usually tell if a master clip is spanned by loading the master clip into the Source 
monitor, switching the Timeline to display the contents in the Source monitor and look 
for edits in the video track.

• The portion of the master clip being used by the motion effect crosses a span boundary.

This change also affects the motion adapters used when mixing frame rates and field motion 
types. If you have a spanned Long GOP master clip and you load it into the Source monitor 
of a project with a different edit rate, the video will not play in real-time in the Source 
monitor. If you edit a portion of the clip into a sequence, the resulting clip in the Timeline 
might play in real-time if the IN and OUT points do not cross a span boundary; otherwise it 
will remain non-realtime and you must render it to play it in real-time.

➤ Bug Number: UDevC00129602. Clips with mixed frame rates and field motion types are 
treated as Optical effects in FilmScribe. In order to generate a valid FilmScribe list, you 
must enable Optical in FilmScribe. Otherwise, the clips containing mixed frame rates and 
field motion types will reference an Optical list that does not exist.
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➤ Bug Number: UDevC00122550. You cannot apply a Timewarp effect on top of a Motion 
Adapter effect. If you attempt to do so, an “Effect does not apply” message appears. 
However, you can promote a Motion Adapter effect to a Timewarp for full access to all 
Timewarp effect parameters. For more information, see “Viewing and Adjusting Motion 
Adapter Parameters”  in the Help.

Panasonic

➤ Bug Number: UDevC00101216. Reveal File does not function on master clips linked from 
P2 cards or virtual volumes.

➤ Bug Number: UDevC00098594, UDevC00097992. Panasonic P2 writeback is not 
supported on the Macintosh platform.

➤ Bug Number: . Export to P2 limitations:

• Use Marks and Use Enabled tracks are ignored on export.

• All Audio must be PCM 16b/48K.

• All audio tracks will be exported, although P2 devices either support 2 or 4 audio tracks. 
Therefore sequences should be built for delivery to the specified P2 playback device. 
Sequences with 6 audio tracks will have 6 audio tracks and the P2 device will only 
playback the first 2 or 4 tracks.

➤ Bug Number: . Importing P2 limitations (Macintosh):

• Importing P2 Clips in a bin is only supported with one P2 Card mounted. With two or 
more P2 cards mounted, use the Media Tool, select the P2 Drives, click All Projects and 
click OK. All Master Clips from the P2 cards will appear in the Media Tool. Drag them 
to a bin.

• When importing from the Panasonic P2 Store device, Media Tool must be used as well 
on Macintosh.

➤ Bug Number: . SD/HD Mixed sequences are not supported.

➤ Bug Number: . 1:1 MXF media cannot be exported in both SD and HD projects. Transcode 
1:1 MXF before exporting.

➤ Bug Number: . (Macintosh) Hotswapping P2 cards with the editor launched is currently not 
supported.

➤ Bug Number: UDevV00090107. Occasionally the File > Import P2 > Media command 
does not consolidate media to the drives.
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Workaround:  Close and re-open the bin and then execute the command again.

➤ Bug Number: UDevC0056503. When you view a P2 clip that spans across multiple P2 
cards in the timeline, you might be surprised as to what you see and don't see due to the 
history of mounting P2 cards on your current system and the P2 cards that are currently 
mounted. Be aware that even though media is offline, or you are not able to view the P2 
media in the Timeline, the media is not lost. The media appears when the card containing it 
is mounted.

➤ Bug Number: 00080719. If you have P2 clips on a P2 card and you display the clips in the 
Media tool, you might be able to delete the audio and video .mxf files from the Media tool. 

➤ Bug Number: UdevC00058135. If you remove a card from a slot in the P2 reader and do 
not put another card in the reader, you must delete the P2 folder before inserting that same 
card in another slot.

➤ Bug Number: UdevC00058133. A DVD drive cannot be a media drive. If a CONTENTS 
folder is located on the root level of the DVD, you might see a “No clips were found” 
message when performing an Import P2 Clips to Bin. 

Workaround:  Create a folder that contains the CONTENTS folder on the DVD. This 
instructs the editor to mount a virtual drive.

➤ Bug Number: UDevC00051731. When the P2 CONTENTS folder is located at the root 
level on a drive where the Avid editing application looks for media files, you might 
encounter errors when importing P2 clips. For example, if you are working on a laptop, the 
Avid editing application and local storage folders are on the same drive and are usually 
located at the root level. If you create virtual P2 volumes on the Desktop, you might 
encounter a “No clips were found” message when trying to import the P2 clips and media. 

Workaround:  If you locate the virtual P2 volume in a different location such as a subfolder 
on the Desktop, you should be able use virtual P2 volumes. 

➤ Bug Number: . If you experience unusually long scan times, check to make sure both the 
local time and Greenwich Mean Time (GMT) are set correctly on your camera. If the GMT 
is not set correctly, you may need updated firmware for your camera. 

➤ Bug Number: . Play performance for a multi-stream sequence suffers when you directly 
access media from the P2 media cards in the AJ-SPX800P camera.

➤ Bug Number: UDEV00163029. If you turn off the P2 card reader while a bin accessing P2 
media is open, attempting to load any P2 clip results in a DISK_FILE_NOT_FOUND 
message in the Source monitor window. The message should read Media Offline.
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➤ Bug Number: UDEV00163032. Dupe detection is not available for P2 source material.

➤ Bug Number: . The following limitations currently apply when working with AVC-Intra 
resolutions:

• Playback of AVC-Intra is not supported with xw8400. Newer hardware does support 
playback.

• Real-time playback support on Avid Symphony Nitris is not guaranteed.

• QuickTime export is not supported.

➤ Bug Number: UDevC00128615. When using AVCIntra media, be aware that this resolution 
uses more memory than other formats.

➤ Bug Number: UDevC00116685.  You cannot export a QuickTime movie using the Same as 
Source option with AVC-Intra material. ProEncode does not work with AVC-Intra material. 
This is related to the QuickTime problem because ProEncode creates a QuickTime 
Reference movie as part of its process.

➤ Bug Number: . If you encounter unusually long consolidation times when working with the 
P2 device, make sure you are using the USB cable supplied by the P2 manufacturer. 

Play

➤ Bug Number: UDevC00117308. You might experience dropped frames when playing back 
XDCAM media with effects. When playing back media, a number of variables affect play 
performance such as your CPU power, GPU power, sequence complexity and the raster 
settings.

➤ Bug Number: UDevC00109242. (MacBook Pro) After an initial launch of the editing 
application when attached to a Mojo, you might receive an “Assertion failed” error when 
playing back an HD sequence. 

Workaround:  Switch the project to NTSC or PAL.

➤ Bug Number: UDevC00101060. You might experience a slight delay at the start of play 
when Output to DV Device is enabled with progressive projects.

➤ Bug Number: UDevC00117987. On certain slower machines, when playing in 
MultiCamera mode, you might notice one or more cameras or the line-cut stutter a few 
seconds into the sequence. This happens most often when displaying the MultiCamera 
composite or line-cut to the client monitor on these older, slower systems. To help improve 
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performance, Avid has provided a console command which allows you to pre-render more 
frames. This will slow down the start of play, but improve the overall playback 
performance.To increase the number of pre-render frames:

Perform the following:

1.  Open the Console window by selecting Tools > Console.

2.  In the Console command line, type the following command followed by the number of 
frames you want to pre-render:

multicampreload 20

3. Press Enter (Windows) or Return (Macintosh). The value is saved. You do not need to 
reenter the command when you relaunch the editing application. To restore the default 
value, enter the command with no value.

➤ Bug Number: UDevC0088738. When you scrub a clip with “Fast Scrub” on, you might 
notice that when you stop scrubbing, the video continues to play in the record monitor. This 
might be more noticeable in HD projects or when you are working on shared storage. Fast 
scrub actually has a number of frames in flight while you drag the blue bar. The in process 
frames continue to play once you stop scrubbing.

➤ Bug Number: UDevC00103865. (Mojo DX) Currently, if you open a 24p PAL, 25p PAL or 
720p 50 project and load a clip into the timeline and then play the clip, you may see frames 
drop.

Workaround:  Set your project to an HD project type and then back to your 24p or 25p 
project. You only have to do this once per session.

➤ Bug Number: UDevC00026088. When you play media and then you press stop, the Source 
monitor stops, but the external client monitor steps back approximately 2 frames.

➤ Bug Number: . (Macintosh) QuickTime reference movies are useful as long as you are 
working with Avid media files available on your local system or in an Avid Unity 
environment. However, if you expect to move the exported QuickTime file to a system that 
doesn't have access to the media, then you should use the standard QuickTime export so the 
media files and QuickTime wrapper can be moved as one file.

➤ Bug Number: Udev00209633. With Full Screen Playback enabled on a single monitor, the 
video might stutter and you might notice tearing toward the top of the image during 
playback. Tearing might also appear if you use variable-speed play.

➤ Bug Number: . When the Avid editing application stops streaming play, a number of 
additional frames are sent to the DNA device in order to keep the client monitor synchronous 
with the desktop display. The DNA device must play out that number of frames after the 



  

62

desktop has stopped playing. To make sure you view the actual last frame, the application 
then snaps the client monitor back to the frame on the desktop. This might be more apparent 
when playing HD media.

➤ Bug Number: . If you do not see video output to your device, make sure that the appropriate 
device is selected in the Special > Device menu. If FireWire is selected in the Device menu, 
make sure Output to Device is selected in the Video Display Settings.

➤ Bug Number: Udev00141002. If you experience a flashing monitor when attempting to 
play using the Japanese version of Windows XP, and your monitor does not appear to be 
covered by anything, adjust the state of your Language bar by maximizing and minimizing 
it. This restores the ability to play.

➤ Bug Number: . (Adrenaline) LTC output is now off by default. To turn it on, open General 
Settings and enable “Generate LTC On Playback.”

Projects

➤ Bug Number: UDevC00100476. The following project types do not support XDCAM or 
HDV raster types:

• 1080p 23.976

• 1080p 25

The only raster type available for these formats is Standard.

➤ Bug Number: UdevC00025426. (Windows Only) Avid Attic folders can only be created by 
Administrators. An Administrator has to first launch the application, open a project, close 
the project and quit the application. Then when a non-Administrator user uses the 
application, their work is saved to the Avid Attic.

➤ Bug Number: UDevC00099790. You should note the following when transcoding media. If 
you have a project in one format, such as 1080i 50 and you add a supported progressive 
format to the clip such as 1080p 25, once you transcode the media, if you try to delete the 
clip, the clip contains both progressive and interlaced media. The delete dialog does not 
indicate that the clip you are trying to delete contains both progressive and interlaced media.

➤ Bug Number: UDevC00025979. For NewsCutter projects, you can only select base 
timecode (TC1) display formats in the Tracking Information menu. You can view other 
timecode formats in the Timeline window, but tracking information does not display above 
the Source/Record monitor except for the base timecode.
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Settings

➤ Bug Number: UdevC00989750. If you take your user settings from your Adrenaline, Mojo 
or Software Only system forward to a system running with a Nitris DX, Fast scrub will be 
disabled. New user settings with a system running with a Nitris DX will have Fast Scrub 
enabled by default.

➤ Bug Number: UDevC00100486 . Currently, when saving toolsets, the bin position is not 
saved.

➤ Bug Number: . Do not carry User Profiles from a previous version to this version. Create 
new user settings. If you do use previous settings, the size of tools and windows might not be 
as expected, especially tools and windows that have been updated for this version.

Titles

➤ Bug Number: 0107356. (Macintosh) You might see vertical gray lines when you 
horizontally scroll the pages of a crawling title in Title Tool.

➤ Bug Number: UDevC00107065. (Macintosh) The background image might not display 
when editing an existing title from the Timeline.

Workaround:  Either promote the title to Marquee, or modify the existing title from the bin.

➤ Bug Number: 106910.  (Adrenaline) Currently, an image might appear distorted in the Title 
Tool if you are in Draft or Best Performance play back mode. 

Workaround:  View the image in the Title Tool in Full Quality or Full Quality 10-bit mode.

➤ Bug Number: UDevC00054752. If you re-create a rolling or crawling title in your 
sequence, the Scroll Position parameter values for the first and last keyframes are not 
preserved. They are set to the default values (start and end).

Workaround:  Promote the title to advanced keyframe model before you re-create.

➤ Bug Number: UDevC00047857. (Macintosh only) If you select the classic Title tool 
eyedropper and then quit the Avid application, the application hangs.

Workaround:  Deselect the Title tool eyedropper before you exit the Avid application. 
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➤ Bug Number: UDevC00080610. Avid suggests that you do not attempt to edit the nested 
tracks of a re-created rolling or crawling title. If you attempt to select or edit one of these 
types of nested tracks, an error occurs. This is also the case with a re-created static title on its 
alpha channel subtrack. 

➤ Bug Number: UDevC00080134. A sys_error occurs when you modify a title to an available 
drive with Render settings that are set to an unavailable drive (a drive that you do not have 
write access to). A .bak file of the title also appears in the bin.

Workaround:  Close the Title tool and change the Render settings to a drive that you do 
have write access to.

➤ Bug Number: UDEV00218429. Character spacing might be inaccurate in Title Tool titles 
using large font sizes. Some character pairs might appear too close together, or overlapping. 
In HD projects, the problem is only visible in the rendered title clip in the bin. In SD 
projects, the problem is visible immediately in the Title Tool. Also, once the problem has 
occurred in text using a large font size, it might persist when you create other text objects in 
the title at any font size.

Workaround:  The best general workaround is to promote the title to Marquee®. Text in 
Marquee titles does not have the same problem at large font sizes. Also, if you do not need 
your final text to use a large font size, avoid converting it to a large font size at any point in 
your workflow, or retype it as a new text object at a smaller size if increasing the font size 
causes the problem.

➤ Bug Number: UDEV00218032. Marquee title format does not need to change in normal 
workflows. In most normal workflows, the title format in Marquee automatically matches 
the project format in your Avid editing application and you do not need to change it. If you 
change the title format in Marquee so that it does not match the project format in your 
editing application, you might see artifacts around the edges of some title objects. One 
situation in which you might need to change the Marquee title format occurs when you are 
creating a title by opening an existing .mqp file. If the .mqp file’s format does not match the 
project format in your Avid editing application, you should change the title’s format to 
match the project format in your editing application. For more information on changing the 
title format, see “Changing Title Formats” in the Marquee Help.

➤ Bug Number: UDEV00221549. When you render a rolling or crawling NTSC SD title with 
Same as Source selected in the Media Creation dialog box in an HD project, you might see 
problems with the title.

Workaround:  For highest quality titles, re-create your title media in the format of the 
project in which you are working; in this case, re-create your SD title media in an HD 
format.



Limitations and Known Issues

65

➤ Bug Number: UDEV00189160. Unrendered back-to-back titles in a 1080i HDV sequence 
might not play in real time. The second title does not display.

Workaround:  Render the titles.

➤ Bug Number: UDEV00162337. Rolling and crawling titles in 24p and 25p projects might 
display a “Layout Mismatch” error when in Full Quality mode.

Workaround:  Select another quality mode. The error also goes away if you toggle to the 
HD project equivalent and load the title.

➤ Bug Number: UDEV00163549. When you re-edit a Marquee title in the Timeline, you 
might see artifacts in the video background. This is cosmetic only and does not appear in the 
resulting title.

Workaround:  If you reedit the title in the bin rather than the Timeline, the artifacts do not 
appear.

➤ Bug Number: UDEV00163010. For projects whose formats are changed to HD, if there are 
Marquee crawls in sequences, these need to be modified to keep them as Avid DSK titles. 
Reedit these titles by using the effect editor to bring up Marquee. If when saving to a bin in 
Marquee you receive a message that the title is animated or that it cannot be saved directly to 
the Timeline, then perform the following workaround.

Workaround:  Select the Crawl text box. Press the “C” toolbar button within Marquee to 
cause the crawling text box to extend for the new larger width of the title. Now you should 
be able to save to the bin or the Timeline as before and the title will not be animated.

➤ Bug Number: UDEV00161170. Page breaks appear on rolling and crawling titles when an 
HD title is over SD media, or an SD title is over HD media.

Workaround:  Recreate the title at the same resolution as the underlying video.

➤ Bug Number: UDEV00136646/UDEV00136165. HD titles appear aliased when you are 
not in Effect mode. Some titles you create in HD projects might look aliased (blocky) when 
you view them at Full Quality in Source/Record mode. To improve the visible quality, render 
the title or view it in Effect mode.

➤ Bug Number: UDEV00134561. The application might appear frozen after you edit a 
Marquee title in the Timeline. If you edit a Marquee title that is already part of a sequence in 
the Timeline and then exit Marquee, you might not be able to perform any other operations. 

Workaround:  Press the Escape key. Use a different user setting to avoid the problem.
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➤ Bug Number: UDEV00138188. Rolling titles created in SD and rendered in HD display 1 
line at the top of the matte when they are rendered.

Workaround:  Recreate the title and matte before you render.

➤ Bug Number: UDEV00135729. If you change the size of text, it might yield different 
kerning results. If you highlight text and change the text properties, the kerning result might 
be different than if you had changed the text properties in the Parent text box. For consistent 
results, change the text properties in the Parent text box.

➤ Bug Number: UDEV00140546, and UDEV00140564. When you edit large or unrendered 
SD crawling or rolling titles in an HD project, switch to SD, promote the title to Marquee, 
save the title in SD, then open the title in HD. 

This workaround is not possible for a 720p project, but you can open the 720p bin in a 30i 
project and modify the title there, as long as there is an SD version of the sequence.

➤ Bug Number: UDEV00139482. Titles created in 4x3 SD and then re-created in 16x9 (SD 
or HD) appear to shift to the left. You must manually re-edit the title in 16x9 for correct 
positioning.

Workaround:  In 16x9 mode, load the original 4x3 title in the Title tool. Click the Selection 
tool, select Edit > Select All, and then click Object-Group. Click Alignment > Center in 
Frame Horiz. Save the title to the bin.

➤ Bug Number: UDEV00141084. You might receive an “Out of Range” error when you try 
to modify and then re-create rolling and crawling titles in the timeline in a 720p project.

Workaround:  Manually re-edit the titles into the sequence.

XDCAM

➤ Bug Number:  UDevC00120079. If you are working with the PDW U1 device and you 
have “Automatically Import Proxies when disk is inserted” selected in the XDCAM Import 
Settings window, you will not receive the automatic prompt to import the proxy clips when 
the disk is inserted. For this device, you must manually import the proxy clips. The high 
resolution batch import process has not changed.

➤ Bug Number: UdevC00121377. (XDCAM writeback) If you export a 720p50 or 720p59 
sequence with an odd number of frames, you will receive a message indicating the sequence 
needs an even number of frames to export successfully. Add or subtract a frame and perform 
the export again.
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➤ Bug Number: UDevC00117308. You might experience dropped frames when playing back 
XDCAM media with effects. When playing back media, a number of variables affect play 
performance; such as your CPU power, GPU power, sequence complexity and the raster 
settings. Depending on the complexity of your sequence, you might need to render some 
effects if you want to preview them in real time and at full quality, or before you can output 
a finished sequence. 

➤ Bug Number: UDevC00116558. When you batch import XDCAM clips from a virtual 
volume, the system re-imports the proxy media into your bin. If you batch import XDCAM 
clips directly from the XDCAM disk, this works as intended. If you do not have access to the 
XDCAM disk, Avid recommends that you import the hi-res XDCAM media when you 
import from a virtual volume and then edit your sequence.

➤ Bug Number: . When you import XDCAM files, be aware that Avid does not support the 
batch import workflow when you are working in the following Sony XDCAM camera 
modes: Picture Cache Record Mode, Interval Record Mode, or VFR (Variable Frame Rate) 
Mode (UCC/OCC - Undercrank/Overcrank). An error message appears which informs you 
that the video is not supported. However, the High-Rez versions of these clips can be 
imported. Their timecode values, however, will be inaccurate. The Avid editor appends its 
own generic timecode to clips recorded in any of the previously mentioned modes.

➤ Bug Number: UdevC00164589. XDCAM proxy media will not export to a QuickTime 
reference movie. This is a limitation for all long-GOP media types.

If you export as a regular QuickTime movie, MPEG 4, or as Windows Media 9, the export is 
successful. Or, you can transcode the proxy sequence to DV 25 or MPEG-IMX and then 
export as QuickTime reference.

Workaround:  Import the whole XDCAM HD clip and then transcode it.

➤ Bug Number: UdevC00078552. The Avid editing applications refer to XDCAM HD 25 
Mbits media files as HDV 1080i 50/60. These Dynamic Relink settings are only available in 
project types 1080i/59.94 HDV or 1080i/50 HDV.

Extending Your Usable Address Space and Adding 
RAM for Improved Performance (Windows)

The Microsoft Windows XP and Windows Vista 32-bit operating systems limit every 
program to 2 gigabytes (GB) of address space. It reserves the remaining 2 gigabytes of 
address space for its own use. The operating system includes a boot-time mechanism that 
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allows applications access to a larger virtual address space than was previously available. 
Avid provides a utility for setting the boot-time mechanism to extend the process address 
space.

For Microsoft Windows XP and Windows Vista 64-bit operating systems, applications are 
allocated an address space well beyond the 2-gigabyte limit allocated by the 32-bit operating 
systems. No utility is needed to tell the 64-bit operating systems to allocate additional 
memory for the applications.

Setting your Avid editing system to access a larger virtual address space might improve 
working with HD projects without running out of memory. Even though you might gain 
more memory space, this can be quickly consumed with bins and complex HD effects. For 
best performance, if you choose to extend your address space beyond 2 gigabytes, you 
should install an additional 1 or 2 GB of RAM.

Using Install3GB.exe to Extend Your Usable Address Space 

It is not necessary to run this executable on Windows Vista 64 systems. Perform this 
procedure on Windows Vista 32 systems or Windows XP systems.

To extend the application address space:

1. Double click the Install3GB.exe file in the Utilities\3G folder where the Avid 
application is installed.

A window opens. You must have administrative privileges to run this utility.

n The hardware and software configuration you are running, for example, Nitris DX, Nitris, 
Mojo, Mojo DX, or Adrenaline, determines the amount of memory you should allocate for 
the application address space.

2. Type the amount of memory you want to allocate for the application space at the 
prompt. The recommended settings are:

- 2700 for Mojo and Adrenaline

- 2700 for Mojo DX and Nitris DX

- 2500 for Symphony Nitris Classic

- 2700 for Software Only systems

Install3GB updates the current configuration you are running. It does not create another 
one. 

After pressing any key the window closes and you will need to reboot the computer. 
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Restoring the Original Configuration

You can restore the system to the original configuration.

To restore the configuration:

1. Run the Install3GB.exe as described in “Using Install3GB.exe to Extend Your Usable 
Address Space” on page 68.

2. Type 0 (zero) for the memory setting.

This removes the “userva” setting in the boot configuration.

3. Reboot the system.

Documentation Changes

The following change has occurred since the print documentation was completed.
You will not receive Keycap labels with the current shipping Avid editor product kits. The 
Keycap labels have been removed from the product kits due to branding changes. We 
apologize for any inconvenience.

Avid Nitris DX REF Sync Update

The second version of the Avid Nitris DX hardware device was released with changes made 
to the REF SYNC connections. The new connections are: REF1 SYNC and REF2 SYNC. 
These changes were not included in current documentation.

You can still follow the instructions to connect a Blackburst or Tri-level device with the 
loopthrough method, but in newer Avid Nitris DX devices you can also connect both a 
Blackburst and a Tri-level device at the same time. This allows you to choose which device 
you want to use in the Video Output Tool (REF 1 or REF 2), without having to physically 
disconnect any cable from your Nitris DX. When you connect to the Avid Nitris DX, the 
Avid editing application detects the connections and displays the appropriate menu choices 
in the Video Output tool Sync Lock menu.

Documentation should include the following changes:

In the Help topic, “Video I/O Connectors for Avid Nitris DX,” should include the following 
writeup for Number 11 REF SYNC:
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In the Help topic, “Video Output Tool Settings: Options Tab,” should include the following 
writeup for Sync Lock:

Ancillary Data Note

The following note was inadvertently left our of the Help topic “Preserving HD Closed 
Captioning and Ancillary Data”:

Number Label
Connector 
Type Function

11 REF SYNC BNC (2) Input and Output. Accepts either Blackburst or Tri-level.

These two sync connections provide a sync input with 
passive loop-through. Either connection can be used for 
input but the other connection must be terminated 
externally or connected to a terminated piece of 
equipment.

REF 1 SYNC
REF 2 SYNC

BNC (2) Depending on the version of Avid Nitris DX, REF 1 and 
REF 2 appear. Accepts both Blackburst and Tri-level.

You can use the above method for REF SYNC, or you 
can connect both a Blackburst and a Tri-level to the REF 
1 and REF 2 connectors. You can switch between both 
devices without having to disconnect the cable. No need 
to terminate.

Option Description

Sync Lock Use this feature to lock your output connection to the reference or an 
internal signal on the Avid input/output hardware. The Avid editing 
application detects the type of Avid input/output hardware you have and 
displays the appropriate options.

• Internal

• Reference

• REF 1

• REF 2

• TriLevel (on some models, TriLevel Sync is automatically detected and 
does not appear as an option)

• Loop through
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The following requirement is necessary when preserving ancillary data: Ancillary data can 
only be preserved when it resides on the V1 video track.

16 Tracks of Audio in the Audio Mixer Tool

Previously, you were limited to 8 tracks of audio in the Audio Mixer tool. You can now have 
16 tracks of audio in the Audio Mixer tool. 

Controlling Character Mapping for Title Text

Recent versions of Avid editing applications use different default character mappings from 
older versions. Some text objects might not display correctly when you open or edit them in 
the current version of your application. In particular:

• Greek text objects created in older versions do not display correctly in recent versions

• Certain characters, such as superscripts or other characters you enter using Alt key 
sequences, might not display correctly

If you experience these problems, you can switch to the older, “classic” character mappings.

To turn classic character mapping on or off:

1. Make sure that the Title Tool is closed.

2. In the Settings tab of the Project window, double-click Interface.

The Interface Settings dialog box opens.

3. Click the General tab.

4. Select or deselect “Use Classic Character Mapping.”

5. Open the Title Tool, switch to a different font, and then switch back to the font you 
need.

This action clears any cached font information and ensures that the character mapping 
change takes effect. 

1080p/29.97 Project Format

Previously, the 1080p/29.97 project was only available on editing applications with 
Nitris DX or Mojo DX hardware. With this release of the editing application, the 
1080p/29.97 project is also available for software only systems. If you working on an Avid 
editing application with an Adrenaline system and you choose the 1080p/29.97 project 
format, you will receive the following message. “This project format is not supported with 
this hardware. We will switch to Software Only mode.” You will not have access to the 
Adrenaline while in this project format. Once you select another project format, you will 
regain access to the Adrenaline hardware.
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Non-Core AudioSuite Plug-ins

The online Help and the Advanced Guide reference Non-Core AudioSuite Plug-ins in the 
Goodies folder. Non-core AudioSuite plug-ins are not included in the Goodies folder. You 
must download Non-core AudioSuite plug-ins from the digidesign.com Web site.

Importing Proxy Media

Avid's feature “Avid Media Access (AMA)” allows you to link directly to P2, XDCAM, or 
XDCAM EX media. However, if you want to import XDCAM proxy media, you need to 
turn off AMA. See “Selecting the AMA Settings” in the Help for information on deselecting 
this option, and then follow the steps in the Help topic “Importing Proxy Media from an 
XDCAM Disc.” 

For more information about AMA and Importing and Exporting, see the section on “File 
Based Media” in the Help or in the Advanced Guide .pdf of your Avid editing system.

Sample Rate Conversion and Audio Import

When you import audio to your project, you have the option of converting the sample rate of 
the source audio files to the project sample rate. You select this option on the Audio tab of 
the Import settings dialog box (see “Import Settings: Audio Tab” in the Help). The default 
setting is to convert all files, which means that your Avid editing application converts the 
sample rate of source files to the project sample rate when it imports the file to your project. 
If you deselect this option, your editing application imports the files at the source sample 
rate.

If you choose to convert your source sample rates when importing audio files, you also have 
the option to skip the conversion of files recorded with pullup or pulldown sample rates. This 
option affects the import process in the following ways:

• Skipping the sample rate conversion of audio files with .1% pullup or pulldown sample 
rates imports the files, bit for bit, with no change to the source audio file. The Avid 
editing application marks the imported files with non-pullup or non-pulldown sample 
rates, and the length and pitch of the imported audio changes by plus or minus .1%. For 
example, a source audio file with a 48048 sample rate is marked on import with a 48000 
sample rate, and it plays back .1% slower than audio with a converted sample rate. 
Because no conversion occurs, importing the files proceeds quickly. This is the default 
setting.

• Converting audio files with pullup or pulldown sample rates results in imported files 
with the project sample rate. The length and pitch of the imported audio matches the 
length and pitch of the source audio. Because the editing application must convert the 
sample rates, importing these files proceeds less quickly than it does when skipping the 
sample rate conversion.
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If you choose not to convert any sample rates when you import audio files, the editing 
application imports the audio files at the source sample rate. This leaves the audio source 
files unchanged, but the application marks any source files with pullup or pulldown sample 
rates with non-pullup or non-pulldown sample rates, and the length and pitch of the 
imported audio changes by plus or minus .1%. Again, this means that a source audio file 
with a 48048 sample rate is marked on import with a 48000 sample rate, and it plays 
back .1% slower than audio with a converted sample rate. 
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Legal Notices
Product specifications are subject to change without notice and do not represent a commitment on the part of Avid Technology, 
Inc.

The software described in this document is furnished under a license agreement. You can obtain a copy of that license by 
visiting Avid's Web site at www.avid.com. The terms of that license are also available in the product in the same directory as 
the software. The software may not be reverse assembled and may be used or copied only in accordance with the terms of the 
license agreement. It is against the law to copy the software on any medium except as specifically allowed in the license 
agreement.

Avid products or portions thereof are protected by one or more of the following United States Patents: 5,077,604; 5,267,351; 
5,309,528; 5,355,450; 5,396,594; 5,440,348; 5,467,288; 5,513,375; 5,528,310; 5,557,423; 5,568,275; 5,577,190; 5,584,006; 
5,634,020; 5,640,601; 5,644,364; 5,654,737; 5,715,018; 5,719,570; 5,724,605; 5,726,717; 5,729,673; 5,745,637; 5,752,029; 
5,754,180; 5,754,851; 5,799,150; 5,812,216; 5,828,678; 5,842,014; 5,852,435; 5,905,841; 5,929,836; 5,930,445; 5,946,445; 
5,986,584; 5,987,501; 5,999,406; 6,016,152; 6,018,337; 6,023,531; 6,038,573; 6,058,236; 6,061,758; 6,069,668; 6,091,778; 
6,105,083; 6,118,444; 6,130,676; 6,134,607; 6,141,007; 6,141,691; 6,198,477; 6,201,531; 6,211,869; 6,223,211; 6,249,280; 
6,269,195; 6,330,369; 6,351,557; 6,353,862; 6,357,047; 6,392,710; 6,404,435; 6,407,775; 6,417,891; 6,426,778; 6,477,271; 
6,489,969; 6,512,522; 6,532,043; 6,546,190; 6,552,731; 6,553,142; 6,570,624; 6,571,255; 6,583,824; 6,596,031; 6,618,547; 
6,636,869; 6,665,450; 6,678,461; 6,687,407; 6,704,445; 6,747,705; 6,763,134; 6,763,523; 6,766,063; 6,766,357; 6,791,556; 
6,810,157; 6,813,622; 6,847,373; 6,871,003; 6,871,161; 6,901,211; 6,907,191; 6,928,187; 7,043,058; 7,081,900; 7,103,231; 
7,266,241; 7,280,117; RE40,107; 7,403,561; 7,433,519; 7,512,885; 7,545,957; D352,278; D372,478; D373,778; D392,267; 
D392,268; D392,269; D395,291; D396,853; D398,912. Other patents are pending.

Avid products or portions thereof are protected by one or more of the following European Patents: 0506870; 0515031; 
0635188; 0674414; 0694243; 0705517; 0752174; 0857293; 0895623; 0976108; 0988756; 1068617; 1068723; 1068734; 
1111910; 1173850; 1629675.  Other patents are pending.

No part of this document may be reproduced or transmitted in any form or by any means, electronic or mechanical, including 
photocopying and recording, for any purpose without the express written permission of Avid Technology, Inc.

Copyright © 2009 Avid Technology, Inc. and its licensors. All rights reserved.

Attn. Government User(s). Restricted Rights Legend
U.S. GOVERNMENT RESTRICTED RIGHTS. This Software and its documentation are “commercial computer software” or 
“commercial computer software documentation.” In the event that such Software or documentation is acquired by or on behalf 
of a unit or agency of the U.S. Government, all rights with respect to this Software and documentation are subject to the terms 
of the License Agreement, pursuant to FAR §12.212(a) and/or DFARS §227.7202-1(a), as applicable.

Trademarks
003, 192 Digital I/O, 192XD I/O, 888 I/O, Adrenaline, AirPlay, AirSPACE, AirSPACE HD, AirSpeed, ALEX, Alienbrain, AniMatte, 
AudioMarket, AudioPages, AudioSuite, AudioVision, AutoSync, Avid, Avid Advanced Response, Avid DNA, Avid DNxcel, 
Avid DNxHD, AVIDdrive, Avid DS Assist Station, Avid EditStar, Avid Learning Excellerator, Avid Liquid, 
Avid Liquid Chrome Xe, Avid MEDIArray, Avid Mojo, AvidNet, AvidNetwork, Avid NewStar, Avid Remote Response, 
AVIDstripe, Avid Unity, Avid Unity ISIS, Avid VideoRAID, Avid Xpress, AVoption, AVX, Beauty Without The Bandwidth, 
Blacktooth, Boom, C|24, CamCutter, CaptureManager, ChromaCurve, ChromaWheel, Command|24, Conectiv, CountDown, 
DAE, Dazzle, Dazzle Digital Video Creator, Deko, DekoCast, D-Fi, D-fx, DigiDelivery, Digidesign, Digidesign Audio Engine, 
Digidesign Intelligent Noise Reduction, DigiDrive, DigiLink, DigiMeter, DigiSerial, Digital Nonlinear Accelerator, DigiTranslator, 
DINR, DNxchange, do more, DVD Complete, D-Verb, Eleven, Equinox, EveryPhase, ExpertRender, Fastbreak, Fast Track, 
FieldPak, Film Composer, FilmScribe, Flexevent, FluidMotion, FXDeko, G7, G-Rack, HD Core, HD Process, HDPack, 
Hollywood DV-Bridge, Hybrid, HyperControl, HyperSPACE, HyperSPACE HDCAM, IllusionFX, Image Independence, iNEWS, 
iNEWS Assign, iNEWS ControlAir, Instantwrite, Instinct, Intelli-sat Broadcasting Recording Manager, Intelli-Sat, InterFX, 
Interplay, inTONE, Intraframe, iS9, iS18, iS23, iS36, ISIS, IsoSync, KeyRig, KeyStudio, LaunchPad, LeaderPlus, Lightning, 
ListSync, Lo-Fi, Magic Mask, Make Anything Hollywood, make manage move | media, Marquee, M-Audio, M-Audio Micro, 
Maxim, Mbox, MCXpress, Media Browse, Media Composer, MediaDock, MediaDock Shuttle, Media Fusion, Media Illusion, 
MediaLog, Media Reader, Media Recorder, MEDIArray, MediaShare, MediaStream, Media Suite, Meridien, MetaFuze, 
MetaSync, MicroTrack, Midiman, MissionControl, Mix Rack, MixLab, Moviebox, Moviestar, NaturalMatch, Nearchive, 
NetReview, NewsCutter, Nitris, NRV-10 interFX, Octane, OMF, OMF Interchange, OMM, OnDVD, Open Media Framework, 
Open Media Management, Palladium, Pinnacle, Pinnacle DistanTV, Pinnacle Geniebox, Pinnacle HomeMusic, 
Pinnacle MediaSuite, Pinnacle Mobile Media, Pinnacle PCTV, Pinnacle PCTV HD Ultimate Stick, Pinnacle PCTV Nano Stick, 
Pinnacle PCTV To Go, Pinnacle Scorefitter, Pinnacle Studio, Pinnacle Studio MovieBoard, Pinnacle Systems, Pinnacle 
VideoSpin, ProEncode, ProServices, ProSessions, Pro Tools, QuietDrive, Recti-Fi, Reel Tape Delay, Reel Tape Flanger, 
Reel Tape Saturation, RetroLoop, rS9, rS18, Salesview, Sci-Fi, Scorch, Scorefitter, ScriptSync, 
SecureProductionEnvironment, Session, Show Center, Sibelius, SIDON, Soft SampleCell, Soft-Clip Limiter, 
Sound Designer II, SPACE, SPACEShift, SpectraGraph, SpectraMatte, Starplay, SteadyGlide, Streamfactory, Streamgenie, 
StreamRAID, Strike, Structure, Studiophile, SubCap, Sundance Digital, Sundance, Symphony, SYNC HD, SynchroScience, 
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SynchroScope, Syntax, Targa, TDM FlexCable, Thunder, Titan, Titansync, TL Aggro, TL AutoPan, TL Drum Rehab, 
TL Everyphase, TL Fauxlder, TL In Tune, TL MasterMeter, TL Metro, TL Space, TL Utilities, Torq, Torq Xponent, Transfuser, 
Trigger Finger, Trillium Lane Labs, TruTouch, UnityRAID, Vari-Fi, Velvet, Venom, VideoRAID, Video Slave Driver, VideoSPACE, 
VideoSpin, Vortx, Xdeck, X-Form, Xmon, Xponent, X-Session, and X-Session Pro are either registered trademarks or 
trademarks of Avid Technology, Inc. in the United States and/or other countries.

Adobe and Photoshop are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States 
and/or other countries. Apple and Macintosh are trademarks of Apple Computer, Inc., registered in the U.S. and other 
countries. Windows is either a registered trademark or trademark of Microsoft Corporation in the United States and/or other 
countries. All other trademarks contained herein are the property of their respective owners. 
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